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Preface

Welcome to the Oracle Customer Relationship Management, Release 11i, suite of 
applications.

This Concepts and Procedures provides information and instructions to help you 
work effectively with Oracle CRM Foundation.

This preface explains how Concepts and Procedures is organized and introduces 
other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

■ Technical Service Representatives (TSR)

■ Customer Service Representatives (CSR)

■ System Administrators (SA), Database Administrators (DBA), and others with 
similar responsibility.

This guide assumes you have the following pre-requisites:

■ Understanding of the company business processes.

■ Knowledge of products and services as defined by your marketing policies.

■ Basic understanding of Oracle and Developer/2000.

■ Background in SQL, PL/SQL, SQL* Plus programming.
xi



Structure
This manual is a compilation of the topics in the online help for Oracle CRM Oracle 
Foundation components. It contains the following topic sections: 

“Understanding” topics provide overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications.

“Using” topics provide process-oriented, task-based procedures for using the 
application to perform essential business tasks. 

“Administering” topics provide task-based procedures for required for ongoing 
system maintenance and includes information on administration tools and utilities.

Related Documents
For more information, see the following manuals:

■ Oracle CRM Foundation Installation Guide
xii



Understanding Assignment Manager

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications. 

Overview of Assignment Manager
Use Assignment Manager to:

■ Assign responsibility for documents and tasks

■ Assess the availability of qualified resources needed to perform a task

The assignment process uses criteria based on preferred resources, availability, and 
territories. Oracle Scheduler provides additional features to optimize scheduling.

For more detail see:

■ Ownership Assignment

■ Resource Availability Assignment

■ Additional Features of Oracle Scheduler

■ Options for Assigning Ownership and Availability

Ownership Assignment
When you create a document or a task, you must assign an owner to it to ensure 
action is taken. A document owner can be a service manager, expediter, marketing, 
service, or sales person. A task owner can be a planner, dispatcher, or service 
representative. An owner is defined as a resource within Assignment Manager.
Understanding Assignment Manager 1



Overview of Assignment Manager
Ownership Assignment

Resource Availability Assignment
A resource must be available before it can perform a task in the field. Assignment 
manager uses the calender to check the availability of a resource. When you assign a 
task to a resource, that resource becomes unavailable for the period of time 
described by that task. 

Task Assignment demanding Resource Availability
2 Oracle CRM Foundation Components Concepts and Procedures



Overview of Assignment Manager
Additional Features of Oracle Scheduler
Oracle Scheduler is an add-on option that is designed specifically for the needs of 
field service. Scheduler is especially helpful for users that have frequent schedule 
changes, relatively large geographical territories per service representative, or dense 
city areas. If you have Scheduler installed, then the Assignment Manager screen 
displays the Intelligent and Window to Promise options. 

When you use the assignment manager to find an available resource, the 
information is passed to Oracle Scheduler. Scheduler then optimizes the schedule, 
based on travel time and a larger set of business-driven criteria.

For more information, see Overview of Oracle Scheduler.

Options for Assigning Ownership and Availability
There are several ways you can assign ownership and availability in Assignment 
Manager. 

There are two options for assigning ownership. 

Option Description

Assisted Use this option if you want assignment manager to find a list 
of qualified resources based on a predefined set of criteria.

With automatic assignment, when no resource can be found 
based upon the selection criteria, use the Assisted screen to 
adjust your criteria and perform a search.

Unassisted Use this option if you want to assign a document without 
taking the criteria into account, or to overrule the criteria set. 
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Assigning Process
There are four options for assigning availability.

Assigning Process
The process of selecting a qualified resource is based upon selection criteria and 
customer selections. To make these criteria effective, some requirements need to be 
met. To understand the process for assigning documents and availability, the 
following is explained in more detail:

■ Assignment Manager Dependencies

■ Assignment Manager Selection Criteria

■ The Effect of Customer Selections

Option Description

Assisted Use this option if you want assignment manager to find a list of 
qualified resources based on a predefined set of criteria.

The resources calendar displays tasks and task status. When no 
qualified resource is shown, you must adjust your criteria and 
re-perform a search.

With automatic assignment, when no resource can be found 
based upon the selection criteria, use the Assisted screen to 
adjust your criteria and perform a search.

Intelligent An option specific to field service that is only available when 
Oracle Scheduler is installed. Oracle Scheduler assigns the task 
to a qualified resource. 

For more information, see Scheduling Intelligent. 

Window to Promise An option specific to field service that is only available when 
Oracle Scheduler is installed. The Window to Promise displays 
time intervals at which a resource (service representative) can 
visit the customer to perform the task. 

For more information, see Scheduling with the Window to 
Promise.

Unassisted Use this option to assign a task without taking the criteria into 
account or actually overruling the criteria set.
4 Oracle CRM Foundation Components Concepts and Procedures



Assigning Process
Assignment Manager Dependencies
To make optimal use of Assignment Manager’s capability of assigning ownership 
and availability, the following dependencies are required.

Assignment Manager Selection Criteria
In addition to the requirements listed in Assignment Manager Dependencies, the 
Assignment Manager uses the following criteria to select a qualified resource for a 
document or task.

The Effect of Customer Selections
The assigning of ownership and availability is influenced by customer selections. 
The customer selections are set up within Assignment Manager and consist of 

Dependency Description

Preferred resource 
information

A preferred resource is a single person or a resource group that 
is defined in Oracle Contracts or recommended from the 
installed base in Oracle Service. When there is no preferred 
resource, use the Assignment Manager set-up screen to define a 
relation between document source and resource definition. 

Territory definition Territories are defined in Territory Manager. A territory has 
resources or resource groups assigned to it. 

For more information, see Territory Manager.

Task duration 
information

Task duration is essential for checking the availability of the 
resource and for designating a resource as unavailable in the 
resources calendar after a task has been assigned.

Resource’s availability 
information

Availability of the resource is provided by the Oracle Calendar 
component in which availability is defined.

For more information, see Calendar. 

Criteria Description

1. Preferred 
Resources

The first and foremost criteria the Assignment Manager considers in 
the assignment process.

2. Territories Used to retrieve all the qualified resources for the assignment from the 
selected territories. 

3. Resource 
Availability

After a preferred or qualified resource, based upon territories, is 
selected, the availability of the resource is considered.
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Assigning Options
making a selection from the selection criteria. The combination of the criteria 
selected results in the selection of the qualified resource. 

For more information, see Selecting Assignment Criteria.

Using Assignment Manager

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

Assigning Options
Choose one of the following options for assigning tasks:

■ Assigning Unassisted

■ Assigning Assisted

■ Assigning Intelligent

■ Assigning with the Window To Promise

■ Selecting Assignment Criteria

Assigning Unassisted
Use the Unassisted option to assign responsibility to a resource of your choice, 
without using the criteria set or the features of Oracle Scheduler.

The Gantt chart displays tasks that have already been assigned in green. Move your 
cursor over a task to view details.

Prerequisites
None

Steps
1. Select the Unassisted option from the Selection Criteria.

2. Make an entry at Resource Partial Name, Resource Type, or Location. 

3. Click Search. 
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Assigning Assisted
The Gantt chart for the resource or resources found is displayed.

4. Double-click on the preferred resource. 

The selected resource appears below the Gantt chart.

5. Enter the preferred Start Time and End Time.

6. Click OK to commit the assignment.

Or click Cancel to leave Assignment Manager without changes.

Assigning Assisted
Use the Assisted option to assign responsibility to a resource based upon the 
selection criteria.

The Assignment Manager always appears with the Assisted option selected and 
displays a list of qualified resources based upon the selection criteria.

The Gantt chart displays tasks that have already been assigned in blue and plan 
options in green. Move your cursor over a task to view details.

Prerequisites
None

Steps
1. Select the Assisted option from the Selection Criteria. 

The calendar for the qualified resource appears.

2. Adjust the Selection Criteria and click Search when the Gantt chart is empty.

For more information, see Selecting your Assignment Criteria.

3. Double-click on the resource with the preferred start and end time. 

The selection appears below the calendar.

4. Click OK to commit the assignment.

Or click Cancel to leave Assignment Manager without changes.
Using Assignment Manager 7



Assigning Intelligent
Assigning Intelligent
The Intelligent option is only available when Oracle Scheduler is installed. Use the 
Intelligent option to assign a task to a resource. 

The Gantt chart displays resources with costs, tasks that have been assigned in blue, 
and travel time between tasks. Move your cursor over a task to view details

Prerequisites
You must have Oracle Scheduler installed.

Steps
1. Select the Intelligent option from the Selection Criteria. 

The Gantt chart for the qualified resource or resources displays a related cost.

2. Adjust the Selection Criteria and click Search when the Gantt chart is empty.

For more information, see Selecting your Assignment Criteria.

3. Double-click on the resource with the preferred start and end time. 

The selection appears below the calendar.

4. Click OK to commit the assignment.

Or click Cancel to leave Assignment Manager without changes.

Guidelines
The resource with the lowest cost related to the assignment is in most cases the best 
option to select. This plan option appears in green on the Gantt chart.
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Assigning with the Window To Promise
Assigning with the Window To Promise
Use the Window To Promise option to assign a time slot to a customer. It is only 
available when Oracle Scheduler is installed.

The Window To Promise displays possible time slots to offer to the customer and 
related cost.

The assignment of the task results in a time slot reserved for a resource. It can later 
be optimized to another resource. 

Prerequisites
You must have Oracle Scheduler installed.

Steps
1. Select the Window To Promise option from the Selection Criteria. 

Possible time slots with related cost are displayed.

2. Adjust the Selection Criteria and click Search when the Gantt chart is empty.

For more information, see Selecting your Assignment Criteria.

3. Select the preferred time slot by checking it. 

The selection appears below the calendar.

4. Click OK to commit the assignment.

Or click Cancel to leave Assignment Manager without changes.

Guidelines
The time slot with the lowest cost related to the assignment is in most cases the best 
option to offer your customer.
Using Assignment Manager 9



Selecting Assignment Criteria
Selecting Assignment Criteria
Use this chart to help you decide which options to choose when setting up 
assignment criteria. This is done in the Assisted screen of the Assignment Manager. 
A selection of the following criteria is possible:
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Selection results in:

X A search for the preferred resource, availability is not taken into 
account. 

X A search for a qualified resource in the selected territories, 
availability is not taken into account.

X A search for an available resource, preferred or qualified is not 
taken into account.

X X A search for the preferred resource, availability is not taken into 
account. 
When no preferred resource is available, a search for a qualified 
resource in the selected territories is done, availability is not 
taken into account.

X X A search for a preferred resource, availability is taken into 
account. 

X X A search for a qualified resource in the territories selected, 
availability is taken into account.

X X X A search for the preferred resource, availability is taken into 
account. 
When no preferred resource is available, a search for a qualified 
resource in the selected territories is done, availability is taken 
into account.
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Understanding Calendar

This topic group provides overviews of the Calendar application and its 
components, as well as explanations of key concepts, features, and functions.

Overview
Calendar is a scheduling tool used to define and view available and non-available 
time for a resource or group of resources. You can create a calendar for yourself or 
another resource, associate work shifts with calendars, and assign a resource to a 
shift depending on availability. There are two types of Calendar screens: Calendar 
Setup and Calendar Datebook.

Calendar Setup
Use the Calendar Setup screens to set up shifts, define available and non available 
time for a resource, and define a calendar for a resource.

Calendar Datebook
Use the Calendar Datebook to view time availability for yourself, a resource, or a 
group of resources. You can also create a private Todo List or access the Tasks screen 
to edit a task for a resource. If you want to change availability times or a work shift, 
you must use the Calendar Setup screens.

Calendar Setup
Use Calendar Setup to create time periods in a calendar datebook for yourself or a 
resource. Calendar Setup uses shifts and patterns to define time availability and 
accommodate the most complex situation for a resource. You can set up everything 
you need to create pertinent information in your datebook. 
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Calendar Datebook
Definition of Available Time
Available time is defined using shifts and patterns. 

What is a shift?
A shift defines when a person is available to work. Using the simplest example, a 
shift can be created that defines the default working week Monday to Friday 8:30 to 
17:00.   

What is a Shift Pattern?
A set of shifts can be set into a pattern. 

For example:

Shift A, named Field Support, starts at 8:00 and lasts 9 hours. 

Shift B, named Stand By, starts at 20:00 and lasts 12 hours. 

On days 1 to 4, the resource can be assigned shift A, and then days 6 and 7 shift 
B, and day 5 can be free. 

Non-Available TIme
Non-available time is a defined block of time when a resource is not available to 
accept a task. 

Non available time can be a number of entries:

■ A personal entry

■ An entry or task sent by another resource.

■ A group appointment or entry created by the resource or another resource.

■ Public holidays

■ Meetings

■ Personal vacation

■ Illness

■ Personal or work appointment.

Calendar Datebook
In your Datebook you can view:
12 Oracle CRM Foundation Components Concepts and Procedures



Calendar Datebook
■ Working hours 

■ Assigned tasks 

■ Personal appointments 

■ Official holidays and vacation days. 

In addition, you can:

■  Create a To Do list for the day, week, or month. 

■ Access the Tasks application to edit a task. 
Understanding Calendar 13



Defining Availability
Using Calendar

This topic group provides process-oriented, task based procedures for using the 
Calendar Setup screens and the Calendar Datebook.

Defining Availability
Defining availability means defining your working hours. A shift is the time a 
resource is available, and a shift pattern is the shift that extends for a longer period 
of time. Use this procedure to define shifts and shift patterns. For more information 
see Calendar Setup.

Prerequisites
None.

Steps
1. Navigate to the Define Shifts screen.

2. In the Name field, create a name for your shift. You will be attaching this 
specific shift to your calendar later. 

3. In the Description field, enter a description of the shift.

4.  In the Effective Dates area, enter the start and end dates.

5. In the Shift Pattern area, define recurrent days off, such as Saturday and 
Sunday. 

The time on the days off should range from 00:00 - 00:00.

6. In the Shift Pattern area, select the day of the week from the list of values.

7. Enter the times you are available for the selected work day.

8. In the Availability Type field, select the availability type from the list of values. 
You can manually enter a type if the list doesn’t provide you with an 
appropriate type. 

9. In the Effective Dates area, enter the start date. The field is automatically 
populated with today’s date. 

10. In the To field, select the list of values to view a calendar. 
14 Oracle CRM Foundation Components Concepts and Procedures



Defining the Calendar
11. Save your work. Your shift pattern is saved to the database. 

Defining Non-Availability (Exceptions)
When you are setting up your calendar you must define not only your working 
hours, but also the times when you are not available for work, such as federal 
holidays, vacation, or sick days. These days are exceptions to your regular working 
shift. Use this procedure to define non-availability. 

Prerequisites
None

Steps
1. Navigate to the Exceptions screen.

2. In the Name field, create a name for your non-available work time. 

3. In the Category field, select a category from the list of values. A category is a 
predefined type of exception. 

4. In the Description field, enter a description of your exception.

5. Click Save. Your exception information is saved to the database.

Defining the Calendar
In order for your shifts and times to appear in the Datebook, you must create a 
calendar. Once your calendar is defined, then you can link your shifts and times to 
it. Use the procedure to define a calendar. 

Prerequisites
None

Steps

1. Navigate to the Define Calendar screen.

2. In the Name field, select the calendar name form the list of values. 

3. In the Type field, select the type of calendar you want to create from the list of 
values. 

4. In the Description field, enter a description of the calendar type. 
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Using the Assign Shift/Exceptions Window
5. In the Effective Dates fields, enter the time period for the calendar. 

Using the Assign Shift/Exceptions Window
You can use the Assign Shift/Exceptions window to:

■ Assign a Calendar to a Shift

■ Assign a Calendar to an Exception

Assigning a Calendar to a Shift
Use this procedure to assign shift patterns that have already been defined to a 
specific calendar. The shifts and patterns are then displayed in your datebook.

Prerequisites
You must first define your availability and non-availability (shift patterns). 

Steps
1. Navigate to Assign Shift/Exceptions.

2. Select the Shifts tab.

3. In the Calendar Name field, enter a calendar name. 

4. Enter the calendar description.

5. Enter the effective dates.

6. In the Shifts field, select your already defined shift from the list of values.

See also
Defining Non-availability (Exceptions)

Defining Availability

Assigning a Calendar to an Exception
Use this procedure to assign exceptions that have already been defined to a specific 
calendar. These exceptions are then displayed in your datebook.

Prerequisites
You must first define your availability and non-availability (shift patterns). 
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Assigning a Resource to a Calendar
Steps
1. Navigate to Assign Shift/Exceptions.

2. Select the Exceptions tab.

3. In the Calendar Name field, select a calendar name from the list of values. 

4. Enter the calendar description.

5. Enter the effective dates.

6. In the Shifts field, select your already defined shift from the list of values.

See also
Defining Non-availability (Exceptions)

Defining Availability

Assigning a Resource to a Calendar
In addition to creating your own personal calendar, you can assign a resource to a 
calendar. Use this procedure to assign a resource to a calendar.

Prerequisites
None

Steps
1. In the Calendar Name field, select the calendar name from the list of values. 

2. From the Resource Type drop-down list, enter the resource type. 

3. In the Name field, enter the name of the resource. 

4. Enter the start and end dates. 

5. Click Save.

Guidelines
You can assign more than one calendar per resource. 
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Creating Tasks and ToDos in a Calendar
Creating Tasks and ToDos in a Calendar
Use the following procedure to gain access to your personal calendar and there 
create and edit tasks and ToDos.

Prerequisites
You must have a personal calendar.

Steps

1. Navigate to Control Tower.

The Control Tower form opens with resources displayed on the Plan Board tab 
at the bottom of the form.

2. Right-click a resource name to open a pop-up menu.

3. Select Show Calendar to open the calendar for the selected resource name.

The Calendar opens to display tasks and ToDos.

■ To create a task, select Task and click New. The Tasks form opens. See 
Creating and Updating Tasks for details.

■ To create or edit a ToDo, select ToDo and click New. The Create/Edit Todo 
form opens. Fill in the appropriate information and click OK. See Creating a 
ToDo List for details.

4. Save your changes and close the Calendar. 

Viewing the Datebook
Use the Datebook screen to view a work shift, task, or time off for yourself or a 
resource, or a group of resources. 

Prerequisites
None

Steps

1. Navigate to the Datebook screen.

2. From the Calendar Name field, select the calendar name you want to view. For 
example, a personal or work calendar.

3. From the drop-down list next to the Resource Employee field, select the 
resource or group of resources available for the chosen calendar. 
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Creating a ToDo List
4. Select either the Day, Week, or Month tab depending on the time period you 
want to view. 

Creating a ToDo List
You can create a personal ToDo list for yourself. Use this procedure to create a ToDo 
list. 

Prerequisites
None

Steps

1. Navigate to the Datebook screen.

2. Select the ToDo radio button.

3. Click New. The Create/Edit ToDo screen appears.

4. Enter the name of your ToDo. This entry appears in the ToDo region.

5. Enter a description of the ToDo. Use this text field to add more detail to your 
one line ToDo name.

6. In the Priority field, enter the priority. 

7. In the Status field, enter the status.

8. Enter the effective dates.

9. Click OK.
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Creating a ToDo List
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Understanding Escalation Management

This topic group provides an overview of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications. 

Overview
Escalations occur in support centers for a wide variety of reasons. An escalation 
management system allows an organization to identify, track, monitor, and manage 
situations that require increased awareness and swift action.

Oracle Support’s Escalation Management features include:

■ Escalation situation tracking information

■ Service Request, Task, and Defect linking capability

■ Ownership assignment based on escalation territory

■ Resolution plan definition with associated tasks and notes

■ Automatic notification of escalation progress to identified contacts

■ De-escalation and closure

■ Automatic notifications of potential escalations, using Oracle Business Rules 
Monitor

Basic information is captured in an escalation document including the requester, the 
business situation, the required resolution date, and additional contacts that are 
involved. 

An escalation is managed by creating an escalation document, assigning an 
escalation owner, defining the actions needed to resolve the escalation, and 
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Workflow Notifications
communicating the progress. Once a situation is de-escalated, the escalation closure 
note is captured and a final communication is sent to the contacts involved.

Workflow Notifications
Notifications are an integral part of the Escalation functionality. Oracle Workflow is 
used to process and deliver the notifications regarding the escalation activity. 

Notifications are sent for the following reasons:

■ Escalation creation

■ Escalation status changes

■ Escalation owner assignment and changes

■ Escalation level changes

■ Escalation target date changes

Notifications are sent to those people (employees or customers) that are identified 
on the Contacts tab, and for which the Notify checkbox has been checked.

Typical recipients include:

■ Owner of the object (Service Request, Task, or Defect) that is being escalated

■ HR manager of the owner of the Escalation document

■ Owner of the Escalation document
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Creating Escalations
Using Escalation Management

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks. See Overview for an explanation of 
the Escalation Management features.

The following topics are covered in this section

■ Creating Escalations

■ Managing a Service Request Escalation

■ Managing a Task Escalation

■ Managing a Defect Escalation

■ Changing the Escalation Level

■ Closing an Escalation

Creating Escalations
Three object types can be escalated: service requests, tasks, and defects. An 
escalation is managed by creating an escalation document, assigning an escalation 
owner, defining the actions needed to resolve the escalation, and communicating 
the progress. Once a situation is de-escalated, a final communication is sent to the 
contacts involved.

An escalation is initiated by a person using a service channel (telephone, web, 
email). An escalation can also be initiated by the system that is based on pre-defined 
rules that have been established to monitor business situations. (See  Start the 
Business Rules Monitor for more information on automated escalations.)

To initiate an escalation you must accept a request for an escalation, review the 
situation, create an escalation document, and notify the involved parties. An 
escalation request can be initiated on behalf of a customer, an employee, or other 
involved party.

See also
Managing a Service Request Escalation

Managing a Task Escalation
Using Escalation Management 23



Managing a Service Request Escalation
Managing a Defect Escalation

Managing a Service Request Escalation
A service request is a document that tracks information regarding a customer’s 
product and service problems. 

Use this procedure to manage a service request escalation.

Prerequisite
A service request has been entered into the system.

Steps
1. Navigate to View Service Request and query the existing service request.

2. Verify that the service request has never been escalated. In the Request 
Information area of the header, verify that “Never Escalated” appears in the 
Escalation Level field. 

You may have to scroll down in the Request Information header region to see 
the Escalation Level field. 

3. From the Tools menu, choose Request Escalation

The Escalations Window appears. The customer and account information fields 
will automatically be filled out, along with the reference document information 
(service request).

4. Select a Status

5. Select a Reason

6. Enter a target date

7. Select the escalation level

8. Assign the escalation to yourself or another existing resource using one of the 
two methods listed: 

a. Select a resource from the list of values.

b. Click Assign to choose an escalation owner from the Assignment Manager.

c. Click Search. The resources from the Escalation Territory(s) of the escalated 
document(s) display. If there are no Escalation Territories set up, then the 
resources from the Catch All territory display.
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Managing a Task Escalation
d. Double-click the resource name to select it.

e. Click OK.

9. Enter a situation summary.

10. Enter the name of the customer or employee contact (requester), and check the 
requester box.

There can be more than one contact, but only one requester. 

11. Optionally, enter any additional contact points.

12. Optionally, add more reference documents to the escalation.

13. Save the escalation, and make a note of the displayed escalation number. 

14. Optionally, click Notes to create a note about the escalation.

15. Optionally, click Tasks to create a task to manage the escalation.

16. Close the Escalation window to return to the Service Request screen.

Re-query the service request to view the updated escalation level.

Managing a Task Escalation
A task is a document that tracks work to be done by a support center. Service 
requests and defects may have associated tasks that define work to be done by a 
support center. A task can be escalated due to an issue with a service request or 
defect. A task can also be escalated independently.

Use this procedure to manage a task escalation.

Prerequisite
A task has been created and entered into the system.

Steps
1. Navigate to Tasks. 

2. Find the task to be escalated.

3. From the Tools menu, choose Request Escalation. 

The Escalations window appears.

4. Verify that the task has never been escalated.
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Managing a Defect Escalation
The escalation level and owner display on the main Task screen.

5. Enter the task number into the Number field in the Reference Documents tab.

6. Select a Status.

7. Select a Reason.

8. Enter a target date.

9. Select the escalation level.

10. Assign the escalation to yourself or another existing resource using one of the 
two methods listed: 

a. Select a resource from the list of values.

b. Click Assign to choose an escalation owner from the Assignment Manager.

Click Search. The resources from the Escalation Territory(s) of the escalated 
document(s) display. If there are no Escalation Territories set up, then the 
resources from the Catch All territory display.

Select a resource by double-clicking on the resource name.

Click OK.

11. Enter a situation summary in the Escalation Summary field.

12. Enter the name of the customer or employee contact (requester), and check the 
requester box.

There can be more than one contact, but only one requester. 

13. Optionally, enter any additional contact points.

14. Save the escalation, and make a note of the displayed escalation number.

Query the escalated task to view the updated escalation level.

Managing a Defect Escalation
A defect is a document which tracks product problems and resolutions. A defect 
can be escalated without an associated service request. Any employee can escalate a 
defect.

Use this procedure to manage a defect escalation.
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Changing the Escalation Level
Prerequisite
■ A Defect with an open status has been created and entered into the system.

■ This defect has not yet been escalated. (You can use the Find window to search 
for an escalation on a particular document.)

Steps
1. From within the Customer Support Responsibility, choose Manage Escalations.

The Escalations window appears.

2. Enter the desired information (no information will default into the form).

3. Enter Defect into the Documents field in the Reference Documents tab.

4. Select a Status.

5. Select a Reason.

6. Enter a target date.

7. Select the escalation level.

8. Assign the escalation to yourself or another existing resource using one of the 
two methods listed: 

a. Select a resource from the list of values.

b. Click Assign to choose an escalation owner from the Assignment Manager.

c. Click Search. The resources from the Escalation Territory(s) of the escalated 
document(s) display. If there are no Escalation Territories set up, then the 
resources from the Catch All territory display.

d. Select a resource by double-clicking on the resource name.

e. Click OK.

9. Enter a situation summary in the Escalation Summary field.

10. Enter the defect owner name in the contact field.

11. Save the escalation, and make a note of the displayed escalation number.

Changing the Escalation Level
A notification is sent whenever a document’s escalation level is changed. 
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Closing an Escalation
Closing an Escalation
To close an escalation, change the status to Closed in the escalation document. A 
notification is sent when an escalation is closed.
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Using Notes

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

Creating Notes
A note records descriptive information that has been generated by users about 
business transactions so that it may be referenced. You can use the Notes 
component from different applications in the product suite to access the comment 
log that relates to a specific transaction. Use this procedure to create a note.

Prerequisites
None

Steps
1. On the application menu bar, click Tools and select Notes.

The Notes window opens.

2. On the Notes toolbar, click New.

The application populates the source, owner, and date fields.

3. Enter the note information in the Notes field.

4. Optionally, click More to enter a note in the Detailed Notes window.

The Detailed Notes window holds textual notes up to 32 K in size.

5. Select note type and status from the list of values for each field.

6. Select from the list of values in the Related To field.
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Finding Notes
7. Enter a value in the Value field.

Define the information you enter in the Related To and Value fields according to 
the relationship between the note and business transaction. Use the Related To 
field to identify the source type for the note information and the Value field to 
specify the source name or number.

8. Save your note.

Note creation is complete.

Guidelines
View the note log in spread table format via the Notes tab and text format via the 
Summary tab. Clicking Latest First in the Summary tab organizes the note history 
so that the most recent note appears at the top of the summary.

References
Finding Notes

Finding Notes
Find notes by performing a search for source number, owner, date, or note type. Use 
this procedure to find an existing note.

Prerequisites
None

Steps
1. On the application menu bar, click Tools and select Notes.

The Notes window opens.

2. On the application toolbar, click Find.

The Find Notes window opens.

3. Select source and number from the list of values for each field and click Search.

The application populates the main note window with the note information.

4. Optionally, search for notes by owner, date, or note type.

Use this procedure to search for notes without a source value.

a. Enter owner, date, or note type and click Search.
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Finding Notes
The application populates the Notes tab in the Notes window with the 
possible matches.

b. Click to select your note and scroll right for additional information.

The note search process is complete.

Guidelines
Further refine your note search by entering Related To information in the Find 
Notes window. Selecting a match option also helps you focus your search.

References
Creating Notes
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Finding Notes
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Understanding Oracle Interaction History

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationship to other Oracle or third-party applications.

The topics covered in this group include:

■ Oracle Interaction History Overview

■ How does Oracle Interaction History Work?

■ Oracle Interaction History’s Dependencies and Integration

■ Oracle Interaction History Features

■ Oracle Interaction History Process Flow

Oracle Interaction History Overview
Oracle Interaction History tracks all customer-agent interactions and serves as a 
repository for the interaction data. You can view the interaction data as well as the 
Oracle CRM application data associated to the interaction. Activities associated to 
each customer-agent interaction can also be viewed. Within Oracle Interaction 
History, you can filter interaction and activity views. Any notes that have been 
entered for an interaction or activity will also display for viewing.

What is an Interaction?
An interaction is a point of contact and may relate to customers, campaigns, agents, 
orders, quotes, etc. This point of contact could be a direct interaction with a 
customer, the customer’s system, a potential customer, or through an automated 
agent. An interaction is generally timed and has an outcome or result that can be 
tracked. Multiple activities can occur during the course of a customer interaction. 
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How does Oracle Interaction History Work?
Each customer-agent interaction may include various forms of communication 
(such as media items).

What is an Activity?
An activity is a business act performed by an agent or automated agent as a part of 
a customer interaction. Interaction activities typically relate to the media item for 
which the activity occurred. Within the customer interaction, the interaction activity 
may involve how a media item was handled, (for example, transferred call). It may 
also include details as it pertains to the Oracle CRM application, (for example, 
request for product information or balance inquiry).

What is a Media Item?
Media items represent a media occurrence that is handled by an Oracle CRM 
application or a user of the application. They can be generated by a customer 
directly, the agent, the system or the Oracle CRM application. Media items can be 
inbound or outbound. For example, an e-mail sent from an agent to a customer 
would be an outbound media item.

How does Oracle Interaction History Work?
When a customer-agent interaction occurs, the interaction data is captured and 
tracked within Oracle Interaction History. 

The following is an example of the types of interaction and activity data that is 
tracked:

■ Customer

■ Account number

■ Agent

■ Campaign

■ Date and time

■ Activity Type (Media and Activity)

■ Outcome or result of interaction or activity

■ Duration

■ Notes
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Oracle Interaction History Features
Oracle Interaction History’s Dependencies and Integration
Oracle Interaction History is integrated with the following Oracle CRM 
applications.

■ Oracle Multi-Channel Manager

■ Oracle iCenter

■ Oracle Advanced Outbound

■ Oracle Universal Work Queue

■ Oracle Customer Care

■ Oracle Support

■ Oracle Telesales

Oracle Interaction History Features
Within Oracle Interaction History, you can view customer-agent interactions, 
activities and notes. Interactions can be filtered by customer, agent, campaign, date 
range, and account number. Activities can be filtered by customer, agent, activity 
type, media type, and date range.

Notes that exist for customer-agent interactions and activities are available for 
viewing in Oracle Interaction History.
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Oracle Interaction History Process Flow
Oracle Interaction History Process Flow
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Searching Interactions
Using Oracle Interaction History

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

The topics covered in this group include:

■ Searching Interactions

■ Viewing Interactions

■ Viewing Interaction Notes

■ Searching Activities

■ Viewing Activities

■ Viewing Activity Notes

Searching Interactions
You can search customer-agent interactions by identifying the criteria for which the 
search will be based. You can filter your search by customer, agent, campaign, date 
range, or account number. You may also search interactions by choosing a 
combination of values. For example, you may need to identify all campaigns that 
pertain to a particular customer.

Once identified, the filtered results will display in the Interactions tab in the Oracle 
Interaction History window. Use this procedure to search customer-agent 
interactions.

Prerequisites
A customer-agent interaction must exist in Oracle Interaction History.

Steps
1. Navigate to the Interactions Filtering Criteria Tab, enter the criteria for 

searching interactions in any of the following fields. 

2. In the Customer field, enter the customer’s name. 

3. In the Agent field, enter the agent’s name.
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Viewing Interactions
4. In the Campaign field, enter the campaign name.

5. In the Date from and to fields, click the list of values button in each field to 
display the calendar. Click the date on the calendar from which to begin the 
search. You may also specify the time. Click OK.

The date will display in the Date from field and you will automatically proceed 
to the Date to field.

6. Click the date on the calendar to end the date range. You may also specify the 
time. Click OK.

The date will display in the Date to field.

7. In the Account field, enter the customer’s account number.

8. Click the Search button.

The interactions that exist for the search performed will display in the 
Interactions tab in the Oracle Interaction History window.

Guidelines
Sentence case must be used when entering the customer’s or agent’s name. For 
example, Fred Smith. A lookup of the customer’s or agent’s name, and campaign 
can be performed by placing the % sign after the partial entry. For example, when 
looking up Fred Smith, you would enter Fred Smi% to find all occurrences.

Viewing Interactions
Once you filter the interactions for viewing, the data associated to the interaction(s) 
will display in the Interactions tab. Any notes that were entered for an interaction in 
the Oracle CRM application will display in the modal window of the Interactions 
tab. Use this procedure to view customer-agent interactions. 

Prerequisites
A customer-agent interaction must exist in Oracle Interaction History.

Steps
1. From the Interactions tab, click on the interaction to view or use the scroll bar to 

scroll through the interactions.

The interaction data is grouped within columns and rows. Dragging your 
mouse over the heading of a column will display a description of the column as 
a tool tip. You can expand and collapse columns in the Interactions tab as 
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Searching Activities
needed. By default, the first interaction that matches the criteria for the search 
will be highlighted. A sort indicator will appear in the column header for the 
column for which the primary sort occurred. A record indicator will display for 
the row currently highlighted.

You can scroll across the Interactions tab to view the columns information for 
the interaction.

Any notes that were entered for an interaction in the Oracle CRM application 
will display in the modal window of the Interactions tab.

2. When finished viewing the interaction(s), close the Oracle Interaction History 
window.

Viewing Interaction Notes
Notes that have been entered for customer-agent interactions display in the modal 
window in the Interactions tab. Use this procedure to view interaction notes. 

Prerequisites
A note must have been entered for the customer-agent interaction in an Oracle CRM 
application.

Steps
1. From the Notes window in the Interactions tab, select the note to view.

2. When finished viewing the interaction note, click on another interaction to view 
another note or close the Oracle Interaction History window to exit from the 
interaction view.

Searching Activities
You can search customer-agent interactions by activity. You can filter your search by 
customer, agent, activity type, media type, date range, or account number. You may 
also search activities by choosing a combination of search parameters. For example, 
you could search for activities by activity type, customer, and date range.

Once you identify the search parameters, the filtered results will display in the 
Activities tab in the Oracle Interaction History window. Use this procedure to 
search activities within customer-agent interactions.
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Viewing Activities
Prerequisites
An activity must exist for the customer-agent interaction in Oracle Interaction 
History and the Oracle CRM application.

Steps
1. Navigate to the Activities Filtering Criteria tab, enter the criteria for searching 

activities in any of the following fields.

2. In the Customer field, enter the customer’s name. 

3. In the Agent field, enter the agent’s name.

4. In the Activity Type field, enter the type of activity.

5. In the Media Type field, enter the type of media.

6. In the Date from and to fields, click the of values button in each field to display 
the calendar. Click the date on the calendar from which to begin the search. You 
may also specify the time. Click OK.

The date will display in the Date from field and you will automatically proceed 
to the Date to field.

7. Click the date on the calendar to end the date range. You may also specify the 
time. Click OK.

The date will display in the Date to field.

8. Click the Search button.

The activities that exist for the search performed will display in the Activities 
tab in the Oracle Interaction History window.

Guidelines
Sentence case must be used when entering search parameters in any of the fields in 
the Activities Filtering Criteria tab. For example, Ann Johnson. A lookup of the 
customer’s or agent’s name can be performed by placing the % sign after the partial 
entry. For example, when looking up Ann Johnson, you would enter Ann John% to 
find all occurrences.

Viewing Activities
Activities performed for a customer-agent interaction in an Oracle CRM application 
are viewed from the Activities tab in Oracle Interaction History. Use this procedure 
to view activities for customer-agent interactions.
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Viewing Activity Notes
Prerequisites
A customer-agent interaction must exist in Oracle Interaction History.

Steps
1. From the Activities tab, click on the activity to view or use the scroll bar to scroll 

through the activities.

The activity data is grouped within columns and rows. Dragging your mouse 
over the heading of a column will display a description of the column as a tool 
tip. You can expand and collapse columns in the Activities tab as needed. By 
default, the activity that matches the criteria for the search will be highlighted. 
A sort indicator will appear in the column header for the column for which the 
primary sort occurred. A record indicator will display for the row currently 
highlighted.

You can scroll across the Activities tab to view the columns information for the 
activity.

Any notes that were entered for an activity in the Oracle CRM application will 
display in the modal window of the Activities tab.

2. When finished viewing activities, click on another activity or interaction to 
view.

Viewing Activity Notes
Notes that have been entered for an interaction activity will display in the modal 
window in the Activities tab. Use this procedure to view activity notes. 

Prerequisites
A note must have been entered for the interaction activity in an Oracle CRM 
application.

Steps
1. From the Notes window in the Activities tab, select the note to view.

2. When finished viewing the activity note, click on another activity to view 
another note or close the Oracle Interaction History window to exit from the 
activity view.
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Overview of Interaction History Administration
Administering Interaction History

This topic group provides task-based procedures that are required for ongoing 
system maintenance and includes information on administration tools and utilities.

Overview of Interaction History Administration
Use the Interaction History Administration window to define attributes that users 
can assign to interaction records. This section covers the following tabs in the 
Interaction History Administration window:

■ Outcomes

■ Results

■ Outcome-Results

■ Results-Reasons

■ Wrap-Ups

Defining Outcomes
The outcome is the immediate response to an agent’s call, such as Contact, No 
Answer, or Busy. One outcome can be used by more than one campaign. To close an 
interaction the agent must report an outcome. Use the following procedure to define 
the outcomes that the agent can use.

Steps
1. In the CRM Administrator responsibility, navigate to Interaction History 

Administration.

2. Select the Outcomes tab.

The Outcome Code and Short Description fields must be defined. Some 
pre-defined values are available for these fields.

3. Click on the Outcome Code field and choose View > Find All.

The pre-defined values are now visible in the Outcome Code and the Short 
Description fields. 
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Defining Results
4. Click the Up or Down arrow keys to review all the pre-defined values. You can 
also enter your own values in either field.

5. If you need to use Numeric Values, check the Telephony Related box. 

Select either Success option–Yes or No–and enter the appropriate Numeric 
Value. Yes has a range of 1 to 100; No has a range of 101 to 255.

6. Choose whether the outcome requires a Private or Public callback.

7. Choose File >Save and Proceed to save the outcome definition.

Guidelines
Some telephony-related applications use Numeric Values, which are recorded as the 
Versatility Code in database tables. Versatility Codes are used by version 3i of the 
following applications: Oracle TeleBusiness for Telecom/Utilities, Oracle 
TeleBusiness for Financial Services, Oracle Integration Manager, and Oracle 
Campaign Plus. If you do not use these earlier applications, you do not need to use 
Numeric Values.

Defining Results
A result of a transaction is the business-related consequence of the agent’s call, such 
as Sale, No Sale, or Complaint. While all transactions must have an outcome, a 
result is not mandatory. Use the following procedure to define a result.

Steps
1. In the CRM Administrator responsibility, navigate to Interaction History 

Administration.

2. Select the Results tab.

The Results Code and Short Description fields must be defined. Some 
pre-defined values are available for these fields.

3. Click on the Results Code field and choose View > Find All.

The pre-defined values are now visible in the Results Code and the Short 
Description fields. 

4. Click the Up or Down arrow keys to review all the pre-defined values. You can 
also enter your own values in either field.

5. If the business rules of the enterprise require a Reason for every Result, check 
the Reason Required box.
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Pairing an Outcome with a Result
You may also define Result-Reason pairs. See Pairing a Result with a Reason.

6. Choose File >Save and Proceed to save the result definition.

Pairing an Outcome with a Result
You can create a new option by pairing an Outcome with a Result. Any Outcome 
may be paired with more than one Result. Each pair appears as one option on the 
agent’s screen.

Steps
1. In the CRM Administrator responsibility, navigate to Interaction History 

Administration.

2. Select the Outcome-Results tab.

3. Select a value from the Outcomes list.

4. Select a value from the Results list.

5. Choose File >Save and Proceed to save the Outcome-Result pair.

Guidelines
The values on the Outcomes list were defined on the Outcomes tab. The values on 
the Results list were defined on the Results tab.

See also
Defining Outcomes

Defining Results

Pairing a Result with a Reason
You can create a new option by pairing a Result with a Reason. Any Result may be 
paired with more than one Reason. Each pair appears as one option on the agent’s 
screen.

Note: Each Outcome-Result pair must be unique. 
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Defining a Wrap-Up
Steps
1. In the CRM Administrator responsibility, navigate to Interaction History 

Administration.

2. Select the Result-Reasons tab.

3. Select a value from the Result list.

4. Select a value from the Reason list.

5. Choose File >Save and Proceed to save the Result-Reason pair.

Guidelines
The values on the Results list were defined on the Result tab. The values on the 
Reasons list were defined on the Reason tab.

See also
Defining Results

Defining a Wrap-Up
A wrap-up is a summary of a transaction that an agent enters after completing a 
transaction. A Promotion code and Campaign Type are essential elements in the 
definition of a wrap-up. When an agent is working on a specific promotion, the 
wrap-ups defined for that promotion become available on the agent’s screen.

The business rules of an enterprise determine whether or not to include the 
Outcome Code, Result Code and Reason Code in the definition of the wrap-up.

Use this procedure to define a wrap-up for an interaction.

Steps 
1. In the CRM Administrator responsibility, navigate to Interaction History 

Administration.

2. Select the Wrap-Ups tab.

3. Choose values for Promotion Code and Campaign Type. Choose values for the 
remaining codes when required.

Note: Each Result-Reason pair must be unique.
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Defining a Wrap-Up
4. Choose File >Save and Proceed to save the wrap-up definition.
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Understanding Oracle 1-to-1 Fulfillment

This topic group provides overviews of Oracle 1-to-1 Fulfillment and its 
components, explanations of key concepts, features, and functions, as well as the 
application’s relationships to other Oracle or third-party applications. 

The Oracle 1-to-1 Fulfillment application supports fulfillment planning, processing, 
and tracking with other Oracle Customer Relationship Management applications to 
automate the distribution of information to customers, prospects, or internal 
departments. Typical users of 1-to-1 Fulfillment include call center Administrators 
and agents, mobile field sales or service representatives, marketing managers, and 
customer care specialists.

The key components of 1-to-1 Fulfillment include the following features:

■ Agent and administrator interface screens that users can embed into Oracle 
Customer Relationship Management applications

■ Use of Oracle Workflow Builder to launch a request, manage the request as it 
moves through the fulfillment cycle, monitor the status of each fulfillment 
request, and notify users about the disposition of particular events

■ Templates that support a wide range of fulfillment scenarios

■ Administrative tools that support the definition and modification of fulfillment 
templates and other fulfillment functions

■ Support of request processing and queuing output to e-mail, and to World Wide 
Web URLs

WARNING: Screens relating to either print or fax functionality or 
capability are not supported and should not be used.
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Understanding Fulfillment Templates
Understanding Fulfillment Templates
A template is a pre-defined package of brochures, newsletters, or other 
customer-oriented information that an agent locates and directs to customers in 
answer to a fulfillment request. Managers or administrators set up templates in 
advance to include specific information materials, called collateral. Although 
fulfillment templates make the fulfillment process more efficient, they are not 
required to fulfill a request.

Templates include a master document that is mail-merged with customer addresses 
to become a cover letter. These master documents are uploaded and stored in the 
Marketing Encyclopedia System (MES). 

When agents fulfill customer requests, a fulfillment server retrieves the master 
document and the MES database tables that contain the necessary information. 

Note: In Release 2.0.1 of 1-to-1Fulfillment, master documents can 
be created in Microsoft Word, saved as HTML files, edited in a text 
editor, and then uploaded to the MES. See Uploading a Master 
Document to the Marketing Encyclopedia System.
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Setting Priorities
Using Oracle 1-to-1 Fulfillment

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

The user interface guides agents through the screens of the fulfillment process. The 
first screen, Introduction, contains instructions that explain how to move through 
the screens and complete a fulfillment request.

Creating a Fulfillment Request
The fulfillment process consists of procedures that you must perform in sequential 
order. The procedures are listed in the Fulfillment Request navigator on the left of 
the screen. You begin at the Introduction screen and proceed to each screen in turn 
by clicking Continue. 

The following are required screens:

■ Customer Information - Verify and update as necessary the Customer Name, 
Company Name, Address, Telephone Number, and E-mail address.

■ Content - Choose the information collateral to send to the customer.

■ Output Method - Choose to produce the content via email or file.

You may also choose the optional screens:

■ Fulfillment Template - Choose a pre-defined template.

■ Attachments - Attach additional content. 

Setting Priorities
To change the priority of a fulfillment in the server queue, use the following steps.

Note: The procedures that are described here explain the general 
process of creating a fulfillment request. Your Oracle business 
product may have slightly modified the 1-to-1 Fulfillment screens 
to better support the business product rules. Therefore, the 
appearance of your 1-to-1 Fulfillment screen may differ slightly 
from the screens described in these instructions. 
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Checking a Request Status
Prerequisites
None.

Steps
1. Navigate to the Output Method Selection screen.

2. Choose Continue.

The Fulfillment Request Confirmation screen opens.

3. In the “Select the priority of your Fulfillment Request” drop-down list, choose 
from High, Regular, or Batch (low).

4. Choose Done.

Checking a Request Status
You may check on the progress of a submitted fulfillment request by clicking View 
Status at any screen.

Viewing All Requests
You may view all requests by clicking View History at any screen. 

Online Help for the User Agent
Online help is not available for the 1-to-1 Fulfillment agent user interface in Release 
2.0.1.
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Changing a Template’s Availability
Administering Oracle 1-to-1 Fulfillment

This topic group provides task-based procedures required for ongoing system 
maintenance and includes information on administration tools and utilities.

Viewing or Updating Listed Items
To view more detail or make changes to an item listed on the selected screen, choose 
the item to open a detailed configuration screen.

Updating a Fulfillment Template
For each template, you may change the Name, Status, and Description.

Prerequisites
None.

Steps
1. Click the Template tab.

The Template screen opens.

2. In the Template screen, choose the name of the template that you want to edit.

The View Template screen opens.

3. Edit the information as necessary.

4. Choose Save.

Changing a Template’s Availability
If you want to prevent a template from being used for fulfillment requests, you can 
change the template’s status. 

Note: Changing the Name of a template that is already in use may 
render that template inaccessible.
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Removing a Master Document from a Template
To change the status of a template, use the following steps.

Prerequisites
None.

Steps
1. In the Template screen, choose the name of the template that you want to 

change.

The View Template screen opens.

2. In the Status pull-down list, choose the appropriate Status: Active or Inactive.

3. Choose Save.

Removing a Master Document from a Template
To remove a master document from a template, use the following steps.

Prerequisites
None.

Steps
1. Choose Template.

The Template screen opens.

2. In the Master Documents table, click Go.

The Master Documents table opens.

3. From the Select Master Document table, choose the master document that you 
want to remove.

You return to the Master Documents table.

4. Click in the Remove check box beside the master template that you want to 
remove.

5. Click Save.
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Creating a Query
Creating a Query 
A query is an SQL statement that directs 1-to-1 Fulfillment to collect specific kinds 
of data from the database when fulfilling a request. 

To create a query, use the following steps.

Prerequisites
None.

Steps
1. In the Query screen, choose Create.

The Create Query screen opens.

2. Enter a unique Name for the new query.

3. Enter a description for the new query.

4. Enter the SQL query string in the provided test field.

See the SQL/PL Query Guidelines following for details on creating a query.

5. Click Create.

You return to the Queries screen. The newly created query displays in the 
Queries list.

See also
Updating a Query

SQL/PL Query Guidelines

Use the following syntax when creating an SQL/PL query:

SELECT <column name> <alias>,
       <column name> <alias>,
       <column name> <alias>,
       <column name> <alias>

Warning: SQL/PL statements typically end with a semicolon (;). 
However, in this case, the query engine appends the semicolon 
itself. Do NOT append a semicolon to the end of this query.
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Creating a Datasource File
FROM <table name>
WHERE <column name> = :<bind variable>

In the above code:

■ Standard SQL/PL commands are all in capital letters.

■ Column names contain underscores.

■ Column name aliases follow the column names and appear before the comma 
or the next keyword. You use aliases as substitutes in master documents for the 
actual (less friendly) column names.

■ The table from which the columns are selected follows the FROM keyword.

■ The bind variable specifies which row is pulled from the table to give the actual 
bits of data for each merged document. A colon in front of a bind variable 
makes it a global variable. This enables the query to recognize it after the value 
is passed in from the user interface. 

For example:

SELECT person_last_name lname, 
       party_id CustNumb, 
       creation_date cdate,
       phone_number phone 
FROM jtf_contact_points_v 
WHERE person_first_name = :fname;

If you enter the above sample query as the query string, then the data source utility 
pulls the aliases rather than the column names when it creates the data source file.

The window opened by the data source utility would then show:

lname    CustNumb    cdate    phone

in a plain background window with nothing else. 

Creating a Datasource File
A datasource file is a text file that contains tab-separated merge fields that have 
been obtained by parsing the selected query. Use datasource files to create master 
documents. 

To create a datasource file, use the following steps.
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Adding a New Group
Prerequisites
The query for the datasource file must already exist. See Creating a Query.

Steps
1. In the Query screen, choose Datasource.

The Create Datasource File for Query screen opens.

2. From the Query Name drop-down list, choose the query.

 The datasources appear in a separate browser window. 

3. From the browser File menu, select Save As.

4. Choose plain text file as the file type (the.txt extension).

5. Navigate to the desired save location.

6. Click Save.

7. Close the browser window.

Downloading a Datasource File
Before a datasource file can be used in a master document, it must be downloaded.

Prerequisites
You must have already created the datasource file. See Creating a Datasource File. 

Steps
1. In the Datasource File Created for Query screen, right click on the Datasource 

File hypertext link.

2. From the drop-down menu, choose Save Link As.

The Save As dialog box opens.

3. Choose the file that you want to download, and click Save.

Adding a New Group
To add an agent group to a fulfillment server, use the following steps.
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Adding Agents to a Group
Prerequisites
None.

Steps
1. Choose the Server tab and then choose Groups.

The Groups screen opens.

2. Choose Add.

The Select Group screen opens.

3. From the drop-down list, choose the group to add to the fulfillment server.

4. Choose Go.

The Add Group screen opens.

5. In the Output Devices tables, choose the output devices to associate with this 
agent group. The output devices should be in a physical location accessible to 
the agents.

6. To make output devices available, choose the appropriate Create button.

Adding Agents to a Group
To add agents to a group, use the following steps.

Prerequisites
None.

Steps
1. Choose the Group tab. 

The Groups screen opens.

2. In the Group Name column, click the name of the group to which you want to 
add agents.

The Group Details screen opens.

3. In the Agents table, choose Go.

The Agents screen opens.

4. Choose an agent from the list of available agents.
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Creating New Groups
You return to the Group Details screen. The agent that you just chose is now 
listed in the Agents table.

5. Choose Update.

You return to the Groups screen.

6. To add additional agents, repeat steps 2 through 5.

See also
Removing Agents from a Group

Creating New Groups

Re-configuring Groups

Modifying a Group-Device Association

Removing Agents from a Group
To remove agents from a group, use the following steps.

Prerequisites
None.

Steps
1. Choose the Group tab. 

The Groups screen opens.

2. In the Group Name column, click the name of the group to which you want to 
add agents.

The Group Details screen opens.

3. In the Agents table, click inside the check box in the Remove column.

4. Choose Update.

You return to the Group Details screen.

Creating New Groups
To create a new group, use the following steps. 
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Re-configuring Groups
Prerequisites

None.

Steps
1. Choose the Groups tab.

The Group Details screen opens.

2. Choose Create.

The Create Group screen opens.

3. Enter a unique name and description of the group.

4. Choose Create.

You return to the Group Details screen.

5. To add agents, choose the Add button and then choose which group to associate 
with the fulfillment server. 

6. Choose Save, and then Done.

Re-configuring Groups
To re-configure a group, use the following steps. 

Prerequisites

None.

Steps
1. Choose the Groups tab.

The Group Details screen opens.

2. Choose the name the name of the group that you want to re-configure.

The group details screen opens.

3. Change any information as necessary.

4. Choose Update to save the information to the database.

You return to the View Groups screen.
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Re-configuring Email Servers
See also
Re-configuring Fulfillment Servers

Re-configuring Fulfillment Servers
To re-configure a fulfillment server, use the following steps.

Prerequisites
None.

Steps
1. Choose the Server tab.

The General screen opens.

2. Update the fields as necessary.

3. To re-configure email servers, choose Continue.

See also
Re-configuring Email Servers

Re-configuring File Servers

Re-configuring Email Servers
To re-configure an e-mail server, use the following steps.

Prerequisites
None.

Steps
1. Choose the Server tab, and then choose E-mail Servers. 

The E-mail Servers screen opens.

2. Change information as necessary.

3. Choose the Output ID link to edit the e-mail server details, including Physical 
Name, Return Address, Incoming Server, and Outgoing Server. 

4. To add a new e-mail server, choose Add.
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Re-configuring Fax Servers
5. To save, choose Update.

Re-configuring Fax Servers

Re-configuring File Servers
To re-configure file servers, use the following steps. 

Prerequisites
None.

Steps
1. Choose the Server tab, and then choose File Servers. button to add a new file 

server. 

2. In the Directory field, edit the full path and file name of the file to which you 
want to send output.

3. Optionally, you may enter a description in the Description field.

4. To re-configure more file servers, repeat steps 1, 2, and 3.

5. To save, choose Update.

Re-configuring Printers

Modifying a Group-Server Association 
Use the following procedure to remove an association between a device server and 
a group.

WARNING: Screens relating to either print or fax functionality or 
capability are not supported, and should not be used.

WARNING: Screens relating to either print or Fax functionality 
or capability are not supported, and should not be used.
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Uploading a Master Document to the Marketing Encyclopedia System
Prerequisites
An association between a group and a device server must exist.

Steps
1. On the Server tab, click the Fulfillment server name to which the group is 

associated.

The General screen displays a description of the Fulfillment server and lists 
additional links on the left. 

2. Click the Groups link.

3. The Groups screen displays the groups associated to the fulfillment server with 
the device servers to which each group is associated.

4. Select the Remove box adjacent to the association you wish to remove.

5. Click Update to complete the process.  

Uploading a Master Document to the Marketing Encyclopedia System
Before the mail merge of a master document and customer information has 
produced a cover letter, you must upload the master document to the Marketing 
Encyclopedia System where it will be available for fulfillment requests.

To upload a master document to the Marketing Encyclopedia System, use the 
following steps.

Prerequisites
■ The master document must be an HTML file or an Adobe Acrobat pdf file.

■ In HTML files, remove from the HTML code any propriety information inserted 
by the word processor, otherwise the server will not process the document. For 
example, saving a Microsoft Word document as HTML inserts Microsoft 
proprietary information in the <HTML> header tag, that is, a line in the header 
stating <META NAME ="Generator" CONTENT="Microsoft Word 97". 
To remove such propriety information, use a generic text editor such as 
Microsoft Notepad.
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Uploading a Master Document to the Marketing Encyclopedia System
Steps
1. Choose the Template tab, and then choose Upload Master Document.

The Upload Master Document screen opens.

2. Click Browse.

The File Upload dialog box opens.

3. Choose the master document file and click Open.

The File Upload box closes and you return to the Upload Master Document 
screen.

4. Click Upload.

The Update Master Document screen opens. 

5. Optionally, in the Description field, type a description of the master document.

6. From the Query drop-down list, choose a query to associate with the master 
document.

7. Choose Update.

You return to the Upload Master Document screen. 

See also 
■  Creating a Query

■ Updating a Query

■ Associate Master Document with Template

Note: If a Master Document requires information that must be 
pulled from a database table, you must create an appropriate query 
to associate with the master document. Otherwise, the correct data 
cannot be sent with the request fulfillment.
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Cancelling a Request
Removing Output Devices and Groups
To remove an output device or agent group, use the following procedure.

Prerequisites
None.

Steps
1. Choose the Server tab. 

The General screen opens.

2. In the Server Name column, choose the name of the relevant server.

3. In the Server Details area, choose the relevant option.

4. In the table, check the relevant Remove box. 

5. Choose Update.

Updating a Query
To change the parameters or other specifications of a query, use the following 
procedure.

Prerequisites
You must have already created the query. See Creating a Query.

Steps
1. Choose the Query tab, and the Queries.

The Update Query screen opens.

2. Update the information as necessary.

3. Choose Update. 

Cancelling a Request
When you submit a fulfillment request, the request goes into a queue for 
processing. When the server begins to process the request, it extracts the request 
from the queue. 
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Resubmitting a Fulfillment Request
To cancel a fulfillment request, in the Administrative Console choose the Status tab, 
and then in the appropriate request Action column choose Cancel.

Resubmitting a Fulfillment Request
Use the following steps to resubmit a fulfillment request.

Prerequisites
You must have already created the fulfillment request.

Steps
1. Choose the Status tab and click the History link.

2. In the row that contains the request identifier that you want to resubmit, click 
Resubmit.

Note: Once the server extracts the request from the queue, you 
can no longer cancel the request.

Note: You can resubmit a successful request.
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Understanding Resource Manager

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications.

Resource Manager Overview
Define resources as the people, places, or things required by multiple application 
components in order to accomplish their objectives. The following diagram 
illustrates the application component relationship to Resource Manager.
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Resource Manager Overview
You can use Resource Manger to import and view resources, define resources, 
define roles, create teams and groups, and organize resources within those teams 
and groups. Defining and organizing your resource information makes your 
resources available to the connected application modules for work action. 
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Creating and Defining Resources
Using Resource Manager

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

Creating and Defining Resources
Use the following steps:

■ to create a resource of category Other,

■ to define the Resource Team, 

■ and to define the group relationships

for newly created resources, or for already imported resources.

Prerequisites
None 

Steps
1. In Resource Manager Navigator, double-click CRM Resources to expand the 

node.

2. Select Resources and click Open.

The Find Resources window opens.

3. In the Find Resources window, select from the list of values in the Category 
field. 

4. Optionally, select from the list of values in the Transaction Number and Name 
fields.

5. Enter the required dates for the resource in the Start Date and End Date fields 
and click Find.

The Resource Search Results window opens.

6. Select the resource that best suits your needs and click Resource Details.

The Resource window opens.
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Creating and Defining Resources
7. Select from the list of values in the User Name field.

8. In the Roles tab, select from the list of values in the Role Type and Role Name 
fields.

The application populates the Start field with the current date. 

9. Optionally, enter an end date to set an effective window for the role, or leave 
the End field blank to make the role effective indefinitely.

10. If you want to define multiple roles for the resource, then select the next row 
and repeat the process.

11. In the Groups tab, click to select a group name from the Name field listing.

12. Select from the list of values in the Role Name field.

The application populates the Start field with the current date. 

13. Optionally, enter an end date to set an effective window for the role, or leave 
the End field blank to make the role effective indefinitely.

14. If you want to define multiple groups for the resource group member, then 
select the next row and repeat the process.

15. In the Teams tab, select a team name from the Name field listing.

16. Select from the list of values in the Role Name field.

The application populates the Start field with the current date. 

17. Optionally, enter an end date to set an effective window for the role, or leave 
the End field blank to make the role effective indefinitely.

18. If you want to define multiple teams for the resource team member, then select 
the next row and repeat the process.

19. Save the resource.

A newly defined resource now exists and may be referenced through Resource 
Manager.

References
Defining Resource Teams

Defining Resource Groups
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Importing Resources
Importing Resources
You can import a resource into Resource Manager from different application 
databases depending on the resource type you choose. After selecting a resource 
based on its type, you identify its role and eligibility dates before saving it to 
Resource Manager. Use this procedure to import a resource.

Prerequisites
None

Steps
1. In Resource Manager Navigator, double-click CRM Resources to expand the 

node.

2. Select Import Resources and click Open.

The Selection Criterion window opens.

3. Select from the list of values in the Resource Category field. 

4. Optionally, refine your resource search by selecting from the list of values in the 
available fields.

Different resource categories have different search field options.

5. Click Search.

The application populates the Category and Name fields in the Search Results 
section.

6. Choose a resource by deselecting the Select check boxes for the undesired 
resources and click Create Resource.

The Default Values window opens, and the application populates the Start Date 
field with the current date.

7. Optionally, select an end date, managing employee, role, and role effective 
dates.

8. Click OK.

The Selected Resources window opens displaying the resource selections.

9. If you want to save a resource to Resource Manager, then deselect the undesired 
resource check boxes and click Save Resource.

Resource importation and definition is complete.
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Defining Resource Teams
10. If you want to further define the resource roles, groups, teams, or other details 
use this procedure.

a. Click Details.

The Resource window opens.

b. Define the resource information via the tab options.

c. Save the resource.

Guidelines
The Comments field in the Selected Resources window indicates whether the 
resource entry is a new record, duplicate record, or has a new role definition.

References
Creating and Defining Resources

Defining Resource Teams
Resource groups provide candidates for teams. But unlike groups, a team is 
composed of different resource types. Team members represent a resource group, 
and are chosen for their availability, qualifications, and location. You define a team 
to organize the necessary resources to accomplish an objective. Teams consist of 
people, places, and things that work together to efficiently complete a project. Use 
this procedure to define a team.

Prerequisites
None

Steps
1. In Resource Manager Navigator, double-click CRM Resources to expand the 

node.

2. Select Teams and click Open.

The Define Teams window opens.

3. Enter a team name in the Team Name field.

4. Enter a brief description of the team in the Team Description field.

5. Enter the effective dates for the team in the Start and End fields.
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Defining Resource Groups
6. In the Members tab, select a member type, category, and member from the list 
of values in Type, Category, and Number fields.

The application populates the Name and Organization Name fields with the 
member’s name and affiliated organization.

7. Optionally, select a member name and click Member Details to view specific 
member information.

8. In the Roles tab, select from the list of values in the Role Type and Role fields.

The role’s relationship to its type is indicated by the check box selection.

9. In the Usage tab, select from the list of values in the Usage field.

10. Optionally, define the members of the team and their roles in the Members tab.

11. Save the team definition.

The new team is accessible from the Team tab in the Resources window.

Guidelines
If you set (check) the new team’s Exclusive flag, then you can only assign resources 
to this team who are NOT assigned to any other exclusive team that has the same 
usage in the same time frame.

References
Creating and Defining Resources

Defining Resource Groups

Defining Resource Groups
A resource group is a collection of resources. Resources fall into three categories: 
people, places, and things. Breaking these categories into groups helps you to 
distinguish the characteristics of its members. Choose to search for an existing 
group or create a new group; then define the group’s members, roles, usages, and 
relations. Use this procedure to define a resource group.

Prerequisites
None
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Defining Resource Groups
Steps
1. In Resource Manager Navigator, double-click CRM Resources to expand the 

node.

2. Select Groups and click Open.

The Define Groups window opens.

3. If you want to find an existing resource group, then use this procedure.

a. On the application tool bar, click Find.

The Find Group window opens.

b. Select a group name from the list of values in the Group Name field and 
click Find.

The application populates the Results section with the group name search 
results.

c. Select a group name in the Results table and click OK.

The application populates the Define Groups window with the group 
information.

4. If you want to create a new group, then use this procedure.

a. Enter a group name in the Group Name field.

b. Enter a brief description of the group in the Group Description field.

c. Enter the effective dates for the team in the Start and End fields.

5. In the Members tab, select a member category and member from the list of 
values in Category and Number fields.

The application populates the Name and Organization Name fields with the 
member’s name and affiliated organization.

6. Optionally, select a member name and click one of the available buttons.

For a detailed description of the group member button options, see the 
Resource Group Member Buttons table in the References section.

7. In the Roles tab, select a role type and name from the list of values in the Role 
Type and Role fields.

The role’s relationship to its type is indicated by the check box selection.

8. In the Usage tab, select a usage description from the list of values in the Usage 
field.
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Viewing Group Hierarchy
9. In the Relations tab, select a group number from the list of values in the Group 
Number field.

The application populates the Group Name field.

10. Select a relation type from the list of values in the Relation Type field.

11. Select effective dates for the relation from the list of values in the Start and End 
Date fields.

12. Save the group definition.

The new group is accessible from the Group tab in the Resources window.

References
Creating and Defining Resources

Defining Resource Teams

Viewing Group Hierarchy
Use this window to view resources who report to a particular person. You can 
restrict your view by resource type, if desired. For example, you can view only 
those resorces that report directly, or you can view all resources that report to a 
particular person.

Prerequisites
None

Steps
1. In Resource Manager Navigator, double-click CRM Resources to expand the 

node.

2. Select Group Hierarchy and click Open.

Resource Group Member Buttons

Button Action

Member Details Opens the main Resource window and record of the member.

Move Member Opens the Move Member window, where you can assign the 
member to another group.

Member Roles Opens the Member Roles window, where you can define the 
member role type, name, and effective dates.
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Viewing Group Hierarchy
The Group Hierarchy window opens.

3. If you want to view the groups of a particular resource member, then select a 
member name or number from the list of values in the Name field and click 
View.

The application populates the Groups section with the member’s groups and 
effective enrollment dates.

4. If you want to view the groups and members of a resource type, then select a 
resource type from the list of values in the Select field and click View.

The application populates the Groups and Members sections with the group 
and member names and effective enrollment dates.

5. If you want to view all the resource groups and members in the database, then 
select ALL from the list of values in the Select field and click View.

The application populates the Groups and Members sections with all the 
groups and their members and their effective enrollment dates.

Guidelines
Selecting Reports Directly from the list of values in the View By field searches the 
database for members that report directly to a resource group.

References
Creating and Defining Resources

Defining Resource Teams

Defining Resource Groups

Importing Resources
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Using the Oracle System Administrator
Console

This topic group provides overviews of the Oracle System Administrator Console, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle applications.

Logging into Oracle Applications
The login window provides fields where every user must enter a login user ID and 
password. After you login, you can use Oracle applications. Use this procedure to 
login to Oracle applications.

Steps
1. Enter your user ID and password in the appropriate fields

2. Click GO.

The next window you see is your personal window. Use this window to 
navigate to the Oracle applications you want to use.

Guidelines
If you do not have access to all the applications you want to use, contact your 
system administrator.

Note: If you do not have a login user ID or password, you must 
register as a new user.
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Registering as a New User
See also
Registering as a New User

Registering as a New User
A user is any person who performs activities on one or more Oracle applications. 
All registered users have a user ID and password that they enter on the login 
window to gain access to the applications. Use this procedure to register yourself as 
a user and define your user password.

Steps
1. In the Welcome window, click Register Here.

 The User Registration window opens.

2. Enter the required information in every field marked with an asterisk (*). 
Indicate whether you are an End user or a Business user.

An End user is an individual that is not representing an organization.

A Business user is an individual that is representing an organization.

3. Click Submit when you have filled all the fields.

If you are an End user, you are now registered.

If you are a Business user, a new window asks you to identify your company.

4. If you are a Business user, continue to enter all required information and click 
Submit when you are finished. 

You are now a registered user.

Defining a Key Name and Value
A property is a combination of a Key and a Value list. A Key is a string, or a 
sequence of letters, numbers, digits, or symbols. A Value list is an ordered list of one 
or more strings. 

The properties in the System Administrator Console are either:

■  System Default Properties, also known as JTF properties

■ Application Properties
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Defining a Key Name and Value
JTF properties can affect the behavior of all Oracle CRM modules. Application 
properties typically affect the behavior of a particular module. The two- or 
three-letter short code that precedes the property name indicates the module to 
which it is associated. If a JTF property and an Application property have the same 
name, the Application property name typically hides the name of the TF property.

An application administrator may or may not have permission to see or edit either 
JTF properties or Application properties. Access to all properties is controlled by 
two permissions:

■ PROPERTY_READ grants permission to read properties 

■ PROPERTY_UPDATE grants permission to read, create, delete and modify 
properties 

The system administrator may have Update permissions for all JTF properties, but 
only Read permission for some CRM modules. An application administrator may 
have Update permission for all the properties of one CRM module, but only Read 
permission for all JTF properties.

You can define a key name and a corresponding value list if you have Update 
permission for the property. Use this procedure to define a new Key and Value. 

Steps
1. Log in to the System Administrator Console as the system administrator or as 

an application administrator.

2. Select the Advanced tab and click Properties.

The View list displays the two-or three-letter code of all the applications to 
which you have access. If you have access to the JTF code, you can define a Key 
and Value for all CRM applications.

3. In the View list, select the three-letter code of the application for which you 
want to define a Key and Value, then click Create.

The Create Key window opens.

4. Enter the keyname in the Key field.

The keyname must be unique, such as guest_user.

Note: Depending on your role and permissions, you may be able 
to define a Key and Value list for one or all applications. 
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Assigning Roles to a User
5. Use the Value fields to enter the new user’s name as it will be used during 
login.

6. Click Update to add the keyname and value to the list of properties.

See also
Table of Module Codes

Assigning Roles to a User

Assigning Roles to a User
The system administrator can assign one or more roles to any registered user. A role 
is a position or job description that is defined on the Security tab. Roles may be 
assigned on the basis of:

■ The application that the user needs to use

■ Responsibilities assigned to the user

Steps
1. Log in to the System Administrator Console as the system administrator.

2. Select the User tab and click Assign Roles.

A Search field appears on the window.

3. Enter the first one or two letters of the user’s name in the Search field and click 
Search.

The search results show a list of user names that begin with the letters you 
entered. Click Next, Last, Previous or First to review all the user names in the 
list.

4. Click the user name to which you want to assign roles.

The Role Mapping window opens to display two lists: Available Roles and 
Assigned Roles.

5. Select a role from one list and click > or < to move it to the opposite list.

■ Click >> to move all Available Roles onto the Assigned Roles list.

■ Click << to move all Assigned Roles onto the Available Roles list.

6. Click Update to complete the task of assigning roles.
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Defining Permissions
See also
Defining Roles

Defining Permissions
A permission consists of a permission name and its definition. A permission is an 
activity that can be performed only with administrative approval. Most Business 
and End users do not perform these activities. Users who can perform these 
activities have been assigned a role that includes one or more permissions. 

Follow this procedure to define a permission.

Steps
1. Log in to the System Administrator Console as the system administrator.

2. Select the Security tab and click Permissions.

The Permissions window displays all permissions that have been defined. 
Permission names are displayed in alphabetical order. The first two or three 
letters of the permission name indicates the name of the module that the 
activity is associated with. Click Next, Last, First or Previous to review all the 
permissions. 

3. Enter a new permission name in an empty Name field. 

The first two or three letters of the name should correspond to the two- or 
three-letter code of a module. Each permission name must be unique.

4.  Enter a description of the activity in the Description field.

5. Click Update to complete the definition. 

The new permission name is automatically filed in alphabetical order. 

WARNING! Do not remove the pre-defined permissions that are 
built into the System Administration Console. These pre-defined 
permissions are essential for stable and reliable performance of 
all Oracle CRM modules. Removal of these permissions could 
cause serious or fatal performance problems. 
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Table of Module Codes
See also
Defining Roles

Table of Module Codes

Table of Module Codes
Each CRM module has a two- or three-letter code. These codes are used on many of 
the System Administration Console window, including Permissions, Properties, and 
Roles. The following table lists the module codes with the module names they 
represent.

Defining Roles
In Oracle CRM applications, roles provide a method of grouping permissions and 
therefore they impart a type of security. A role may be a specific position or job 
description within the enterprise. Each role may be associated with Permissions and 
Data Access.

Follow this procedure to define a role and map permissions to the role.   

Steps
1. Log in to the System Administrator Console as the system administrator.

2. Select the Security tab and click Roles.

The Roles window displays all roles that have been defined. Role names are 
displayed in alphabetical order. The first two or three letters of the role name 
indicates the name of the module that the activity is associated with. Click Next, 
Last, First or Previous to review all the roles

Module Code Module Name

CS Oracle Field Service

CSS Oracle Support, includes the Defect Management System

IBE Oracle iStore

IBU Oracle iSupport

IBY Oracle iPayment

IEM Oracle eMail Center

JTF Oracle CRM Foundation
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Setting Up Default Responsibilities
3. Enter a new role name in an empty Name field. 

The first two or three letters of the name should correspond to the two- or 
three-letter code of a module. Each role name must be unique.

4. Enter a description of the role in the Description field.

5. Click Update to complete the definition. 

The new role name is automatically filed in alphabetical order. 

6. Find the new role is the list of role names and click the role name.

The Role Mapping window opens to display two lists: Available Permissions 
and Assigned Permissions. The Role Name appears above the lists.

7. Select a permission from one list and click > or < to move it to the opposite list.

■ Click >> to move all Available Permissions onto the Assigned Permissions 
list.

■ Click << to move all Assigned Permissions onto the Available Permissions 
list.

8. Click Update to complete the role mapping.

See also
Table of Module Codes

Defining Permissions

Setting Up Default Responsibilities
A responsibility in Oracle Applications is a way to control access to menus. Each 
responsibility is tied to an application. When users register, you can grant them 
access to a default responsibility, so that they can begin using the application right 
away. During installation and implementation, use Oracle Applications Forms to 
determine the Default Application ID and Default Responsibility ID for each Oracle 
CRM module.

The Oracle System Administrator Console provides two types of users:

■ Business users– individuals who represent an organization

■ End users–individuals who are not associated with an organization 

In the System Administrator Console, you can associate each user type to one 
Default Application ID and one Default Responsibility ID. Use the following 
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Setting Up Default Roles
procedure to make these associations. The default responsibility can allow access to 
one or more CRM modules with minimal permissions.

Steps
1. Log in to the System Administrator Console as the system administrator.

2. Select the Setup tab and click Default Responsibilities.

The Register Default Responsibility window opens.

3. Choose a user type and enter the appropriate IDs.

4. Click Submit to complete the setup.

See also
Defining Permissions

Setting up Default Roles

Setting Up Default Roles
You can set up customized default roles for your enterprise, each with its own set of 
permissions or privileges. Then, as a security measure, you can associate default 
roles that are granted to a user type during user registration.

The Oracle System Administrator Console provides two types of users:

■ Business users– individuals who represent an organization

■ End users–individuals who are not associated with an organization 
 

Use the following procedure to specify the default roles to be assigned to a user 
type.

Steps
1. Log in to the System Administrator Console as the system administrator.

2. Select the Setup tab and click Default Roles.

Note:  When you set up default roles for all Oracle CRM modules, 
use CRM_DOMAIN. this is the default domain for all roles and 
permissions.
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Overview of Extensibilities
The Select Account Type and Domain window opens. This window contains 
two lists: Account Type and Domains. 

3. Select one item in the Account Type window, select CRM_DOMAIN in the 
Domain window and click Next.

The Groups window displays two lists: Available Roles and Assigned Roles.

4. Select one or more Available Roles and click > to move it to the Assigned Roles 
list.

The roles in the Assigned Roles list will be assigned to the user type you 
selected in step 3.

■ Click >> to move all Available Roles onto the Assigned Roles list.

■ Click << to move all Assigned Roles onto the Available Roles list.

5. Click Update to complete the role default assignment.

See also
Setting Up Default Responsibilities

Defining Roles

Overview of Extensibilities
A profile is a way to store information on the database tables. After the database is 
deployed, you may find you need to define new properties to store additional 
information. The System Administrator can define new profiles. Once a new profile 
has been added, other applications can share the profile by subscribing to it, or the 
profile can be reserved for a single application. 

Each profile is a logical extension of a base table and has a base property definition 
that captures the additional information. You can also add extended properties, to 
capture more information about a base property. Property rules define the 
conditions that must exist to make the base properties valid. 

See also
Creating a Property

Subscribing to a Profile

Modifying the Base Properties of a Profile

Adding Extended Properties
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Creating a Property
Creating Property Rules

Creating a Property
Each profile has base properties that govern how the object appears in the 
application and if there are any required values the user must use to describe the 
object. Use this procedure to create properties for a profile.

Prerequisites
Profiles must already exist in the base table. 

Steps
1. Log in to the System Administrator Console as the system administrator.

2. Select the Advance tab and click Extensibilities.

The Profiles window displays Base Table Names and Profile Names.

3. Click the Profile Name for which you are creating a property.

The Base Property Name window displays the existing properties for the profile 
you selected.

4. Click Add.

The Create Property window displays fields you can use to define the new 
property. You must enter information in the fields marked with an asterisk (*).

■ Use the Property Disabled field to indicate whether or not the property 
appears on the application window.

■ Use the Required field to indicate whether or not users must define a value 
for this property.

5. Click Create to complete the property creation.

See also
Subscribing to a Profile

Adding Extended Properties

Creating Property Rules
84 Oracle CRM Foundation Components Concepts and Procedures



Modifying the Base Properties of a Profile
Subscribing to a Profile
Multiple applications can share, or subscribe to, a profile. When applications share a 
profile, they share access to information about the object associated to the profile.

Prerequisites
A profile must exist and it must allow sharing.

Steps
1. Log in to the System Administrator Console as the application administrator for 

the application that wants to share a profile.

2. Select the Advance tab and click Extensibilities.

The Profiles window displays Base Table Names and Profile Names.

3. In the list of Profile Names, find the profile you want to share.

If you can subscribe to the profile, the Subscribed column displays a white box.

4. Select the Subscribed box next to the name of the profile you want to share. 

5. Click Subscribe to complete the subscription.

See also
Overview of Extensibilities

Modifying the Base Properties of a Profile
The base properties of a profile define the property and how it appears in the 
application window. Use the following procedure to modify the base properties of a 
profile.

Prerequisite
The profile must exist and have base properties that can be modified.

Steps
1. Log in to the System Administrator Console as the application administrator for 

the application that subscribes to the profile.

2. Select the Advance tab and click Extensibilities.

The Profiles window displays Base Table Names and Profile Names.
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Adding Extended Properties
3. Click the Profile Name that has base properties you want to modify.

The Base Property Name window displays the base properties associated to the 
selected profile.

4. Click the Base Property Name you want to modify.

The Base Property Definition window displays the current definition of the base 
property. This definition may include Extended properties. You can modify the 
following fields:

■ The Property Disabled field indicates whether or not the property appears 
on the application window.

■ The Required field indicates whether or not users must define a value for 
this property.

■ The Data Type field indicates the format of the value that users can use to 
define the property.

5. If you want to modify Extended Properties, click the name of the Extended 
Property to open the Edit Extended Property window.

6. Click Update to confirm your changes. Or click Restore to bring back the 
original base properties.

See also
Adding Extended Properties 

Adding Extended Properties
An extended property is an additional attribute of a basic property. Use the 
following procedure to add an extended property.

Prerequisites
A profile must have base properties defined.

Steps
1. Log in to the System Administrator Console as the application administrator for 

the application that subscribes to the profile for which you are adding extended 
properties.

2. Select the Advance tab and click Extensibilities.

3. Select the Profile Name and then select the Base Property Name.
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Creating Property Rules
4. On the Base Property Definition window, click New.

The Create Property window displays fields you can use to define the extended 
property.

■ Use the Property Disabled field to indicate whether or not the property 
appears on the application window.

■ Use the Required field to indicate whether or not users must define a value 
for this property.

■ Use the Data Type field to indicate the format of the value that users can 
use to define the property.

5. Click Create to complete the extended property creation.

See Creating Property Rules to define conditions that make the base properties 
valid.

Creating Property Rules
A property rule is a condition that must exist for a property to be valid, or acted 
upon. Property rules are applied to both base properties and extended properties. 
Use this procedure to create a property rule.

Prerequisites
 An extended property must exist for which you are creating a property rule.

Steps
1. Log in to the System Administrator Console as the application administrator for 

the application that subscribes to the profile for which you are adding extended 
properties.

2. Select the Advance tab and click Extensibilities.

3. Select the Profile Name and then select the Base Property Name.

4. Click New under the list of Extended Properties.

The Create Rule window displays fields you can use to define the Property 
Rule. You must enter information in the fields marked with an asterisk (*).

5. Click Create to complete the Rule creation.
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Changing Your Profile Preferences
See also
Adding Extended Properties 

Changing Your Profile Preferences
When you initially register as a user, the system administrator may give you one or 
more responsibilities. Each responsibility gives you access to one or more CRM 
modules. 

On the General Preferences window, if you have multiple responsibilities, you can 
switch to another one. The General Preferences window also provides fields for 
changing the display for language, currency, date, and tables.

Use the following procedure to manage your responsibilities and display options.

Steps
1. Log in to the System Administrator Console.

2. Click Profile in the right corner of the window, just above the menu bar. 

The General Preferences window opens to display the Current and Default 
Responsibilities that have been assigned to you.

If this window is not displayed, click the Preferences link on the left side of the 
window.

3. Choose another responsibility from the Current Responsibility list. 

4. Choose options from the other available fields as needed.

5. Click Update to enforce your changes. Or click Restore to return the values that 
initially displayed in the window.

Changing a Personal Profile
When you register as a user, you enter a user ID and a password that you use each 
time you log in to Oracle CRM modules. You can change your password and your 
user information on the Personal Profile window. Use the following procedure to 
change your personal profile. 

Steps
1. Log into the System Administrator Console.

2. Click Profile in the right corner of the window, just above the menu bar. 
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Using the Quick Find
The General Preferences window opens.

3. Click the Personal Profile link on the left side of the window.

The Personal Profile window opens.

4. Modify any of the fields on the window.

5. Click Update to enforce your changes. Or click Restore to return the values that 
initially displayed in the window.

Using the Profile Address Book
When you register as a user, you enter contact information for the organization you 
are representing. You can use the Address Book to modify this contact information 
when necessary. Use the following procedure to modify contact information.

Steps
1. Log into the System Administrator Console.

2. Click Profile in the right corner of the window, just above the menu bar. 

3. Click the Address Book link on the left side of the window.

The Address Book window opens.

4. Modify any of the fields on the window.

5. Click Update to enforce your changes. Or click Restore to return the values that 
initially displayed in the window.

Using the Quick Find
The Quick Find feature provides a way for you to search for particular information. 
The kinds of information for which you can search changes, depending on the CRM 
module you are using. 

The Quick Find feature consists of two fields. 

1. Use the list in the first field to identify the category of information in which you 
are searching.

2. Use the second field to enter one or more words, letters, or symbols to define 
what you are searching for.

3. Click Go to initiate the search.
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Setting User Responsibilities for an Existing AOL User
The Search Results window displays all matches to your query.

Guidelines
You can enter the plus sign (+) in front of a letter in your search definition to make 
the letter mandatory in the search result. Enter the minus sign (-) to exclude a letter 
from the search result. Quick Find does not support “wild cards.”

Setting User Responsibilities for an Existing AOL User
For user accounts that have been created through Oracle ERP or Oracle Application 
Forms, certain profile options and responsibilities need to be set up before these 
users can login to the HTML Applications. 

Prerequisites
The user account must exist.

Steps
1. Log in to the Oracle Applications as a sysadmin user, with System 

Administrator responsibility 

2. In the Navigator window, choose Security->User->Define.

3. In the Users window, search on the user name of the user in which you are 
interested. 

4. Assign to that user any of the HTML application-related responsibilities that 
you want the user to have.

For example, this could be the CRM HTML Administration responsibility for 
logging into the HTML Admin Console, or the System Administrator 
responsibility.

5. Save your work, and close the Users window. 

6. Open the Profile->System Profile Options form 

7. Click User, and type in the user name for the field value 

8. Using wildcards, search for profile options JTF_PROFILE_DEFAULT%.

9. Set the JTF_PROFILE_DEFAULT_RESPONSIBILITY profile option at the User 
level to the responsibility ID that corresponds to the responsibility you      
assigned in the earlier steps. 
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Setting User Responsibilities for an Existing AOL User
(To determine the responsibility ID, go to the Responsibility screen, Help -> 
Diagnostics -> Examine -> Responsibility ID Value.)

This value determines the menu that is rendered when the user logs in. 

10. Set the JTF_PROFILE_DEFAULT_APPLICATION profile option at the User 
level to the application ID that corresponds to the default responsibility. 

11. Save your work, and quit out of the profile window. 

Guidelines
The following table lists the profile options to be set.

Profile Options For a User 

Profile Options Comments

ICX_LANGUAGE Sets the language (for example, American English).

JTF_PROFILE_DEFAULT_CURRENCY Sets the currency code.

JTF_PROFILE_DEFAULT_NUM_ROWS Sets the total number of rows that display (for example, 10).

JTF_PROFILE_DEFAULT_BLANK_ROWS  Sets the number of blank rows that display (for example, 10).

JTF_PROFILE_DEFAULT_APPLICATION  Sets the application ID (for example, 690).

JTF_PROFILE_DEFAULT_RESPONSIBILITY Sets the responsibility ID (for example, 21841).

JTF_PROFILE_DEFAULT_CSS Sets the default style sheet, set this to JTFUCSS.CSS.

Note: The DEFAULT_APPLICATION and DEFAULT_
RESPONSIBILITY profile option values are the most important all 
those listed. These values determine the menu structure that is 
drawn upon user log in. 
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92 Oracle CRM Foundation Components Concepts and Procedures



Using Task Manager

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications.

Creating and Updating Tasks
Tasks consist of work assignments that detail the actions required of company 
personnel. Use this procedure to create or update a task.

Prerequisites
Before you create a task from a template, a template design must exist. 

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, click New.

The Tasks window opens.

3. Use one of the following procedures to create a task:

a. Select the template information from the list of values for the required 
fields, and click Create Tasks.

b. Click Create Task from Template to use a template.

The Create Tasks from Template Group window opens. 

Enter your basic task information into the required fields by selecting from 
each list of values. 
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Setting Dependencies for Tasks
4. Click More.

The Task Details window opens.

5. In the Resource tab, define Requirements by selecting from the list of values for 
each field.

6. In the Dependencies tab, enter the task dependencies by selecting from the list 
of values for each field.

7. In the References tab, enter the reference objects by selecting from the list of 
values for each field.

8. In the Recurrences tab, enter the recurrence rules by selecting from the option 
buttons and the list of values for each field.

9. In the Resources tab, enter the resource assignments by selecting from the list of 
values for each field.

10. Save your task.

The new task number appears in the task spread table.

11. If you want to update a task, then perform the following steps:

a. Navigate to Task Manager.

b. In the Find Tasks window, click Find.

c. The Tasks window opens.

d. Update information.

e. Save your changes.

Guidelines
Clicking Launch Workflow in the Tasks window automatically reserves the 
designated resources and notifies the task owner of task creation via e-mail. 

References
Designing Task Templates 

Launching Task Workflow

Setting Dependencies for Tasks
Dependencies determine the order among tasks. When an action requires the 
creation of several tasks, setting a dependency for each task ensures the completion 
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Assigning and Scheduling Resources
of a designated task before the start of another. Use this procedure to set task 
dependencies.

Prerequisites
A task must exist before you can set dependencies for it. 

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the Dependencies tab, select the dependent task number from the list of 
values in the Task Number field.

The corresponding task name populates the Task Name field.

5. Enter a numerical value in the Offset field.

6. Select from the list of values in the UOM field and click OK.

7. Save your task.

A task dependency now exists for the original task.

Guidelines
Use a numerical value of time in the Offset field. The Offset value determines the 
time that separates the action of initial tasks from subsequent tasks. Use this feature 
to organize tasks with time-sensitive restrictions.

References
Creating and Updating Tasks

Assigning and Scheduling Resources
Define resources as the tools and personnel necessary for the completion of a task. 
The task owner assigns and schedules the required resources after choosing the best 
available options. Use this procedure to assign and schedule resources.
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Assigning and Scheduling Resources
Prerequisites
None 

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the Resources tab, select from the list of values in the Resource Type field.

Choosing Select populates the Assignments Type and Name fields for the 
corresponding Resource Type.

5. Enter a numerical value in the Unit field.

The Unit value determines the numbered amount of a particular resource.

6. Select from the list of values in the Type and Name fields.

7. If you want to schedule a resource, then select Schedule.

Enter scheduled distance and duration values, and select a unit of measure.

8. If you want to update actual schedule information, scroll right and enter the 
actual values in the required fields and click OK.

9. Save your task.

Resource assignment and scheduling is complete.

Guidelines
The Enabled check box allows you to activate varied resources according to task. 
Use this option to select live resources when updating.

For tracking purposes, update the Actual schedule fields after task completion.

References
Creating and Updating Tasks
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Tracking Planned, Scheduled, and Actual Dates
Scheduling Recurring Tasks
Schedule a task to automatically reoccur daily, weekly, monthly, or yearly. Use this 
procedure to schedule recurring tasks.

Prerequisites
None

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the Recurrences tab, select an Occurrence option.

5. Select from the list of values in the required fields and click OK.

6. Save your task.

The task now reoccurs automatically.

References
Creating and Updating Tasks

Tracking Planned, Scheduled, and Actual Dates
Track task progress by entering date information after three task milestones:

■ Task creation

■ Resource reservation

■ Task completion

Use this procedure to track planned, scheduled, and actual dates.

Prerequisites
None
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Setting Task Flags
Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. In the Dates section, enter information into the Planned fields.

The application populates the GMT field with the correct Greenwich Mean 
Time Deviation value.

4. After reserving resources for the task, enter information into the Scheduled 
fields.

5. Upon task completion, enter final information into the Actual fields.

6. Save your task.

Reference date information to track task completion status.

Guidelines
Updating the Actual Start and End Dates in the Resource tab populates the 
corresponding Actual date fields in the main Task form.

References
Creating and Updating Tasks 

Assigning and Scheduling Resources

Setting Task Flags
Use task flags to select different configurations for each task. Setting flags 
customizes each task according to your needs. Use this procedure to set task flags.

Prerequisites
None

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.
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Documenting Multiple Contact Information
3. Click More.

The Task Details window opens.

4. In the Miscellaneous tab, select task flags.

For a detailed description of flag options, see the Task Flag Definitions table in 
the References section.

5. Click OK.

6. Save your task.

The task owner receives the task flagged as a Milestone.

Guidelines
Optionally, design templates with predetermined flags.

References
Creating and Updating Tasks 

Designing Task Templates

Documenting Multiple Contact Information
Associate more than one person’s name and contact information with a task. Use 
the Contacts tab to document the complete list of contacts for a particular task while 
defining the primary contact individual. Use this procedure to document multiple 
contact information.

Prerequisites
None

Task Flag Definitions

Task Flag Definition/Action

Auto Notification Launch notification workflow automatically.

Milestone Indicate task importance.

Private Restrict task access to non-task owners.

Publish Allow task notification to non-task owners.

Restrict Closure Require the completion of a child task before a parent task.
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Tracking a Task Record
Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the Contacts tab, enter information into the Contacts fields.

5. Enter the corresponding telephone information into the Contact Telephones 
fields.

6. Select the Primary checkbox to mark the primary contact individual and click 
OK.

7. Save your task.

The task contact information is recorded.

Guidelines
Also use the Contacts tab to enter contact information for dependent tasks. The 
contact individual may differ for task dependencies. Entering multiple contacts and 
selecting one as the primary records the correct communication channel for the 
selected task.

References
Creating and Updating Tasks 

Setting Dependencies for Tasks

Tracking a Task Record
The task record documents and dates the history of task change. Each update to a 
task results in an entry to the task record. The task record provides a trail from the 
original task through to the current task status. Use this procedure to access the task 
record.

Prerequisites
None
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Launching Task Workflow
Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the Audit tab, view the task history.

Each row documents the status of the task. The bottom row contains the most 
recent task record.

5. Scroll to the right to view the New and Old values.

6. Click OK to return to the Task Details window.

Guidelines
The Audit tab contains a read-only record of the task change. 

References
Creating and Updating Tasks

Launching Task Workflow
Define workflow as the actions following a task creation or update. After creating or 
updating a task, you need to notify the task assignees of their involvement. The 
Launch Workflow feature automates this process and contacts the necessary parties 
via e-mail.

Prerequisites
None

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.
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Linking Tasks to Source Documentation
The Task Details window opens.

4. Select the Resources tab.

5. Create an Assignee by filling in the fields from the list of values.

6. Click OK.

7. In the Task Details window, click Launch Workflow.

8. Save your task.

Workflow e-mails the task owner and resource scheduler with the task creation 
or update information.

References
Creating and Updating Tasks 

Setting Task Flags

Linking Tasks to Source Documentation
Linking a task to a source document allows you to reference pertinent background 
information. Define source documentation as the original request document that 
resulted in the creation of a task. Use this procedure to link a task to its source 
document.

Prerequisites
None

Steps
1. Navigate to Task Manager.

2. In the Find Tasks window, find or create a task.

The Tasks window opens.

3. Click More.

The Task Details window opens.

4. In the References tab, select from the list of values in the Reference Type field.

The application populates the Details field with a description of the reference 
type.

5. Enter the identification number of the source document in the Number field.
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Linking Tasks to Source Documentation
6. Optionally, enter additional information into the Usage and Reference Code 
fields.

7. Click OK.

The type and number information populate the Source Doc Type and Source 
Doc Number fields in the main task list.

8. Save your task.

The source document now links to its corresponding task.

Guidelines
Double-clicking the Source Doc field in the main task screen brings up the source 
document for viewing.

References
Creating and Updating Tasks
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Linking Tasks to Source Documentation
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Understanding Territory Management

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications. 

Territory Management Overview
You can use Territory Management to automatically assign sales, service, and 
collection teams based on their availability and expertise. You can also use it to 
make sales, service and collections information more secure by restricting personnel 
access to customer data. 

Most sales and service territories are one dimensional. They assign tasks to 
employees based on postal code, area code, country, vertical market, size of 
company, or product expertise. Territory Management makes it possible for you to 
create multidimensional territories using a number of such criteria. 

For example, you can assign all large customers within a specific geographical area 
only to those sales representatives who have an expert knowledge of a product and 
have been with the company for more than one year.

 Territory Management lets you create multiple such territories for individuals or 
for whole teams of sales, service, and collections representatives.

You can think of Territory Management as a high-level programming tool that 
determines the assignment of tasks and resources within your company. 

After you define territories using Territory Management, you must run the 
Generate Territory Package concurrent program. This compiles the territories you 
create into the logic, called the territory package, that is used by your application 
for the territory assignment itself.
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Basic Territory Building Blocks
After the concurrent program runs successfully, the Territory Management module 
together with Oracle Calendar and Oracle Human Resources automatically assign 
the most qualified individual to a task. 

See Also
Setting Up Territories for Your Organization

Basic Territory Building Blocks

Different Ways of Creating Territories

Basic Territory Building Blocks
Here are the basic building blocks you use to define territories:

■ Qualifiers

■ Territory types

■ Territory templates

■ Territories

■ Escalation territories

Qualifiers
Qualifiers are the criteria used to delineate a territory. There are two types of 
qualifiers: transaction qualifiers and resource qualifiers. 

Use transaction qualifiers to specify how the territory module assigns transactions. 
This includes accounts, leads, opportunities, and service requests. Examples of 
transaction qualifiers include: customer name, postal code, state, and product 
interest. 

Resource qualifiers specify what attributes are used to select the individuals 
responsible for those transactions. Examples include job title, competence, and 
language.

Territory Management provides a large number of preset qualifiers of both types 
(see List of Predefined Territory Qualifiers for a list). Your implementation team can 
also define qualifiers tailored to your company. See Creating Custom Qualifiers for 
details.
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Different Ways of Creating Territories
Territory Types
Use territory types to group transaction qualifiers used for creating territories. This 
saves you time when you are creating similar territories. Suppose you want to 
create territories by geographical area. In this case you can create a territory type 
with the Country and Postal Code qualifiers. 

Territory Templates
Use a territory template to create many similar territories at the same time. Suppose 
you have two large customers and you wish to create a territory for each of them for 
every state in the United States. Creating individual territories requires you to 
repeat the same procedure 100 times, once for each of the 50 states for each 
company. Using a territory template, you can create all of the 100 territories at the 
same time. 

Territories
A territory consists of qualifiers and their values. You can create a territory 
individually or you can create a large number of territories all at the same time 
using a Territory template. (See Different Ways of Creating Territories for more 
details.) 

Escalation Territories
You can create alternate territories to automatically reassign a sales lead or service 
call when certain conditions are not met. For example, if a repair team assigned a 
repair does not take action within five business days, then that repair can be 
assigned automatically to another group. 

Different Ways of Creating Territories
You can create a territory in one of three ways:

■ Create an individual territory. 

You can create a standalone territory, entering territory qualifiers and their 
values directly. This method does not leverage your work because you have to 
add both qualifiers and their values for each territory you create. Do not use 
this method often.

■ Create a territory using a territory type. 

Creating territories using a territory type is a two step process:
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List of Predefined Territory Qualifiers
1.  Create the territory types by adding the transaction qualifiers you are 
going to use. 

2. Use the territory types to create individual territories.

Use this method for creating multiple territories with similar characteristics. 
Using territory types to create territories saves you time because you do not 
have to add qualifiers to each individual territory, but you still have to create 
each individual territory separately by entering values for the qualifiers.

Territory types limit you to using transaction qualifiers, so if you plan to use 
resource qualifiers, then you must use territory templates instead.

■ Create a large number of territories all at the same time using a territory 
template. 

Suppose you wish to create a separate territory for every state in the United 
States for two large customers. Creating individual territories requires you to 
repeat the procedure 100 times, once for each of the 50 states for each company. 
Using territory types, you still must create each 100 territories separately 
although the process is somewhat shorter. By following the procedure outlined 
in Using a Template to Create Large Numbers of Territories, you can create all 
of the 100 territories at the same time.

List of Predefined Territory Qualifiers
The Territory Management application includes pre-defined qualifiers for different 
types of applications:

■ Oracle Defect Management

■ Oracle Sales and Marketing

■ Oracle Service

■ Trade Management

Predefined Territory Qualifiers

Application Type Qualifier Type Qualifier Name

Defect Management Defect Transactions Company Name

Defect Management Defect Transactions Country

Defect Management Defect Transactions Account Code

Defect Management Defect Transactions Postal Code
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List of Predefined Territory Qualifiers
Defect Management Defect Transactions Area Code

Defect Management Defect Transactions Customer Name Range

Defect Management Defect Transactions Number of Employees

Defect Management Defect Transactions Province

Defect Management Defect Transactions County

Defect Management Defect Transactions Sub Component

Defect Management Defect Transactions Error Code

Defect Management Defect Transactions Platform Specific Flag

Defect Management Defect Transactions Func Defect Flag

Defect Management Defect Transactions UI Defect Flag

Defect Management Defect Transactions Tier Code

Defect Management Defect Transactions Priority

Defect Management Defect Transactions Severity

Defect Management Defect Transactions Component

Defect Management Defect Transactions Phase

Defect Management Defect Transactions Problem Type

Defect Management Defect Transactions Platform

Defect Management Defect Transactions Product

Defect Management Defect Transactions State

Defect Management Defect Transactions City

Defect Management Resource Job Title

Defect Management Resource Competence

Defect Management Resource Postal Code

Defect Management Resource Resource Category

Defect Management Resource Resource Type

Defect Management Resource City

Defect Management Resource Language

Predefined Territory Qualifiers

Application Type Qualifier Type Qualifier Name
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List of Predefined Territory Qualifiers
Defect Management Resource Position

Sales Account Company Name

Sales Account Contact Interest

Sales Account Account Hierarchy

Sales Account SIC Code

Sales Account Business Line

Sales Account Number of Employees

Sales Account Sales Partner/Reseller

Sales Account Province

Sales Account Customer Name Range

Sales Account County

Sales Account Area Code

Sales Account Lead Quantity

Sales Account Lead Rank Code

Sales Account State

Sales Account Postal Code

Sales Account City

Sales Account Account Code

Sales Account Account Classification

Sales Account Country

Sales Lead Lead Expected Purchase

Sales Lead Lead Promotion Identifier

Sales Lead Purchase Amount

Sales Lead Budget Amount

Sales Lead Lead Inventory Item

Sales Opportunity Opp Expected Purchase

Sales Opportunity Opportunity Classification

Predefined Territory Qualifiers

Application Type Qualifier Type Qualifier Name
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List of Predefined Territory Qualifiers
Sales Opportunity Opportunity Channel

Sales Opportunity Opp Inventory item

Sales Opportunity Market Segment

Sales Opportunity Total Amount

Sales Resource Job Title

Sales Resource Competence

Sales Resource Postal Code

Sales Resource Resource Category

Sales Resource Resource Type

Sales Resource City

Sales Resource Position

Sales Resource Language

Service Account Company Name

Service Account Number of Employees

Service Account Province

Service Account Customer Name Range

Service Account County

Service Account Area Code

Service Account State

Service Account Postal Code

Service Account City

Service Account Account Code

Service Account Country

Service Resource Job Title

Service Resource Position

Service Resource Language

Service Resource Competence

Predefined Territory Qualifiers

Application Type Qualifier Type Qualifier Name
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List of Predefined Territory Qualifiers
Service Resource City

Service Resource Postal Code

Service Resource Resource Category

Service Resource Resource Type

Service Service Request Request Type

Service Service Request Request Problem Code

Service Service Request Request Urgency

Service Service Request Request Status

Service Service Request Support Site

Service Service Request Request Creation Channel

Service Service Request Inventory Item

Service Service Request Customer Site

Service Service Request Platform

Service Service Request Request Severity

Service Task Task Type

Service Task Task Status

Service Task Task Priority

Trade Management Market Resource Job Title

Trade Management Market Resource Position

Trade Management Market Resource Language

Trade Management Market Resource City

Trade Management Market Resource Resource Category

Trade Management Market Resource Resource Type

Trade Management Market Resource Postal Code

Trade Management Market Resource Competence

Trade Management Market Trade Account Company Name

Trade Management Market Trade Account County

Predefined Territory Qualifiers

Application Type Qualifier Type Qualifier Name
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Territory Planning
Territory Planning
Before using the Territory Management module, you must analyze the territory 
setup in your organization. You need enterprise-wide cooperation and feedback 
and you must expect to make multiple territory revisions in the first months of 
operation as your enterprise discovers omitted information or territories that do not 
work on a day-to-day basis.

Here are the general steps to follow in the planning process:

1. Review your existing territories. 

You need the following types of information:

Trade Management Market Trade Account Party Relation

Trade Management Market Trade Account Customer Profile

Trade Management Market Trade Account Site Classification

Trade Management Market Trade Account Business Purpose

Trade Management Market Trade Account Account Hierarchy

Trade Management Market Trade Account Province

Trade Management Market Trade Account Location

Trade Management Market Trade Account Country

Trade Management Market Trade Account State

Trade Management Market Trade Account Postal Code

Trade Management Market Trade Account City

Trade Management Market Trade class qualifiers Company Name

Trade Management Market Trade class qualifiers Customer Category

Trade Management Market Trade class qualifiers Customer Sub Category

Trade Management Market Trade class qualifiers Customer Class

Trade Management Market Trade class qualifiers Account Classification

Trade Management Market Trade class qualifiers Sales Channel

Trade Management Market Trade class qualifiers Account Code

Predefined Territory Qualifiers

Application Type Qualifier Type Qualifier Name
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Tips for Fine-tuning Territory Assignment Performance
■ How your territories are currently assigned (by state, by industry, by zip 
code, by account, and so on)

■ The names and current territory assignments for your sales or service 
personnel

■ The names of employees in other organizations who receive account, lead, 
and opportunity information and how that information is accessed and 
used

■ Your products and how they are differentiated 

2. Decide what qualifiers you want to use to assign accounts or opportunities to 
territories and create territory types to restrict your territory restrictions.

3. Decide on the hierarchy of territories.

4. Decide if you need escalation territories and how they fit in the hierarchy.

5. Decide what qualifier values you wish to use for assigning territories.

6. Identify any overlapping territories and decide the order in which the 
application picks them. 

Rank any overlapping territories from 1 to n to determine the order. A territory 
with a smaller rank wins over a territory with a higher rank. In case of a tie, the 
assignment is made randomly. 

For example, if a customer can be assigned to two overlapping territories which 
are ranked 1 and 2 respectively, the territory with a rank of 1 wins over a 
territory with a rank of 2.

7. Test your strategy before implementing territories throughout the company.

Remember that your first territory setup is not necessarily the one that works best. 
You can achieve optimum territory definition only gradually after much fine-tuning 
to accommodate user reactions and various interests in your organization.

Tips for Fine-tuning Territory Assignment Performance

Ranking Strategy
You can speed up processing time by ranking more frequently used territories 
higher than less frequently used territories.

For example, if you have two sales organizations, one in Canada and one in the 
United States, and you know that some 80 percent of your customers are coming 
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Setting Up Territories for Your Organization
from the United States, then rank the US territory higher than the Canada territory. 
The application saves processing time as a result because it looks for a US territory 
before it looks for a Canadian territory.

You must use caution that your modifications do not result in erroneous 
assignments, however. 

Suppose you have two overlapping territories:

■ Territory A

Qualifier: Company Name Range= F%

■ Territory B

Qualifier: Company Name Range=Ford Motor Co%

If you rank territory A higher than territory B, then territory B never receives 
any assignments. All Ford accounts are assigned to territory A.

Using Territory Management

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

Setting Up Territories for Your Organization
Implementing Territory Management involves four required and one optional step:

1. Planning 

2. Creating custom qualifiers (Optional step)

3. Selecting qualifiers 

4. Creating territories

5. Running the Generate Territory Package concurrent program 

Note: The % symbol is a wild card.
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Selecting Qualifiers
Selecting Qualifiers
You must select the qualifiers you are going to be using by checking the Enabled 
flag before you can create your territory types, territory templates, and territories. 

If you need to set up qualifiers of your own, then follow the procedure outlined in 
Creating Custom Qualifiers.

Prerequisites
A plan for territory setup. 

Steps
1. From the Admin menu, choose Setup Qualifiers.

The Setup Qualifiers window appears.

2. From the View menu, choose View Query by Example > Enter.

3. In the Usage field, enter %<a descriptive word for your application 
group>%. 

For example, for sales applications, enter  %sales%. For service applications, 
enter %service%. 

4. From the View menu, choose View Query by Example > Run.

5. From the list of valid qualifiers for your application family, select those you 
wish to use by checking the Enabled Flag check box. 

6. Click OK when you are done.

Using the Navigator
Use the Navigator to view your territory structure and to locate those territories, 
territory types, and territory templates you wish to modify. 

You can use the Navigator to:

■ View the structure of your territories in a tree format and create new territories.

■ View and modify your territory types and the territories created using them.

■ View and modify the escalation territories you have created.

■ View and modify your territory templates and the territories created using 
them. 
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Viewing Territory Types
■ Search for the territory you wish to view or modify.

You can view and modify any item in the tree by double-clicking on it. This 
launches the Territory Details window.

Viewing Territory Structure as a Tree
Use this procedure to display your territories in a tree format. 

You can insert a territory below any territory in the tree. See Creating Individual 
Territories for details.

Prerequisites
The Navigator must be the active window.

Steps
1. From the View By drop-down list, select Territories.

2. If you wish to view territories effective on a specific date, then enter that date in 
the Date field. Unless you enter a different date, the territories are effective 
today.

3. Click the nodes of the tree containing a plus sign to open them.

4. To view or modify a particular territory, double-click it. The application 
launches the Territory Details window.

Viewing Territory Types
Use this procedure to display your territory types. 

Prerequisites
The Navigator must be the active window.

Steps
1. From the View By drop-down list, select Territory Types.

2. If you wish to view territory type effective on a specific date, then enter that 
date in the Date field. The default is today.

The Navigator displays the territory types you have created.
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Viewing Escalation Territories
If you have used a territory type to create territories, then those territories 
appear in a tree under that territory type.

3. Click on any nodes containing a plus sign to open them.

4. To view or modify a specific territory type, double-click it. The application 
launches the Territory Details window.

Viewing Escalation Territories
Use this procedure to display your escalation territories you have created. 

Prerequisites
The Navigator must be the active window.

Steps
1. From the View By drop-down list, select Escalation Territories.

2. If you wish to view escalation territories effective on a specific date, then enter 
that date in the Date field. The default is today.

3. To view or modify a particular territory, double-click it. The application 
launches the Territory Details window.

Viewing Territory Templates
Use this procedure to display your territory templates. 

Prerequisites
The Navigator must be the active window.

Steps
1. From the View By drop-down list, select Territory Templates.

2. If you wish to view territory templates effective on a specific date, then enter 
that date in the Date field. The default is today.

The Navigator displays the territory template you have created.

If you have used the territory template to create territories, then those territories 
appear in a tree under that territory template.
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Using the Territory Details Window
3. To view or modify a particular territory template, double-click it. The 
application launches the Territory Details window.

Searching the Navigator
Use this procedure for finding territories, territory types, escalation territories, and 
territory templates in the Navigator.

Prerequisites
None.

Steps
1. Select the Navigator as your active window.

2. From the Administration menu, choose Search.

The Territory Search window appears.

3. From the Search For drop-down list, select the information type you are 
searching for: territory, territory type, escalations, or territory template.

4. In the Basic tab, enter the information you are searching for. 

5. If you wish to search for specific qualifier values, then enter these in the 
Advanced tab.

6. Click Search.

The results of your search appear in the Search Results field below.

7. If you wish to view any of the found items, then:

a. Select the item from the list.

b. Click Populate Tree.

The Navigator opens to the selection you selected.

Using the Territory Details Window
Use the Territory Details window to:

■ Create territories

■ Create escalation territories

■ Create territory templates
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Creating Territory Types
Creating Territory Types
Use this procedure to create territory types. A territory type is a grouping of 
transaction qualifiers you can use to simplify and systematize the territory creation 
process. 

Prerequisites
■ You must plan your territories before using this procedure.

■ You must set up your qualifiers.

Steps
1. From the Administration menu, choose Create Territory Type.

The Create Territory Type window appears.

2. From the View By drop-down list in the Navigator, select By Territory Type.

The Navigator displays the territory types you have created as nodes on the 
tree. Each territory you create appears under the territory type that created it.

3. If you believe a similar territory type already exists, then you can save yourself 
some work by copying it. Here is how:

a. Search for a similar territory type.

b. If you find a similar territory type, then click Copy Type. The application 
creates a copy of the existing territory type that you can modify.

4. In the Usage field, use the List of Values (LOV) to select the type of application 
using this territory type. 

5. Enter a name for the territory type and a description.

6. If you wish to limit the use of this territory by date, then enter a date range.

7. Use the LOV to select one or more types of transactions with the application 
type. Available values include account, lead, opportunity, and service request.

8. In the Qualifiers region, use the LOV to enter the qualifiers you wish to use for 
the territories you create.

9. If you wish to allow overlap for a qualifier, then click the Allow Overlap? check 
box.

Allowing overlap allows you to assign overlapping territory values to the same 
qualifier. For example, suppose you wish to create a territory for John Smith 
where the qualifier Postal Code has the values 94400 - 94410 and 94408 - 94420. 
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Creating Individual Territories
By enabling overlap, you can enter both ranges as values for the qualifier. With 
no overlap, Territory Management prevents you from entering the second range 
of values for the qualifier. 

10. Click OK to save your work and exit.

Creating Individual Territories
Use this procedure to create individual territories with or without using territory 
types. To create large numbers of territories at the same time see Using a Template 
to Create Large Numbers of Territories.

Prerequisites
■ If you want to use territory types to create territories, then you must create the 

territory types first.

■ You must draw up a plan for your territories.

Steps
1. In the Navigator, select the territory that serves as a parent to the new territory. 

If this is the first territory you are creating, then select Catch All.

2. Right-click with the mouse and select New from the pop-up menu.

The Territory Details window appears.

3. In the Overview tab, use the List of Values (LOV) in the Usage field to select the 
type of application you want to use this territory. Your selection limits the types 
of qualifiers you can use in the territory definition.

4. In the Category region, select the Standard radio button.

5. Enter a name and description for the territory. 

6. If you want to limit the time the territory is effective, then enter the start and 
end dates. By default the territory become effective on the date you create it.

7. Make sure the parent territory is the territory your selected in the Navigator. If 
this is not the parent territory, then use the List of Values (LOV) to select the 
appropriate parent territory.

8. If you have created an escalation territory for this territory, then enter it using 
the LOV in the Escalation field. 
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Selecting the Resources for a Territory
9. Use the Transaction Types LOV to select one or more types of transactions with 
the application type. Available values include account, lead, opportunity, and 
service request. Note that some application types allow you only one 
transaction type.

10. If you wish to use an existing territory type to create this territory, then use the 
LOV to enter it in the Type field. If you use a territory type, then you are 
restricted to using the qualifiers set up in that territory type. 

11. Select the Transaction Qualifiers tab.

12. If this territory is part of a hierarchy of territories, then click Show Inherited 
Qualifiers to examine which qualifiers this territory has inherited from its 
parent territory(ies). You do not want to use any of these qualifiers in the 
territory you create to avoid duplication.

13. If you are creating a new territory without a territory type, then enter the 
qualifiers you are going to use in the Transaction Qualifiers region. 

14. If you have used a territory type to create this territory then the qualifiers are 
already prefilled.

15. If you wish to enter overlapping values for a qualifier, then check the Overlap 
Allowed check box.

16.  Enter the values for each qualifier. See Entering Qualifier Values.

17. Select the resources for the territory using the procedure outlined in Selecting 
the Resources for a Territory.

18. If your territory hierarchy includes territories below the current territory, then:

a.  Select the Sub-Territories tab.

The tab lists all the sub-territories for the current territory. Since you have 
not created any sub-territories, this list is blank.

b. Click New Sub-Territory and repeat the territory creation procedure for the 
new sub-territory.

19. Click Save on the toolbar to save your work.

Selecting the Resources for a Territory
Use this procedure to select the resources you want to staff a territory. 
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Selecting the Resources for a Territory
Prerequisites
The Territory Details window is active with the territory you wish to staff 
displayed.

Steps
1. Select the Resource Qualifiers tab.

2. In the Name fields of the Resource Qualifier region, use the list of values (LOV) 
to enter the qualifiers related to the skill set of the employees assigned to this 
territory.

3. Enter the values for each qualifier. See Entering Qualifier Values.

4. Select the Resources tab.

5. If you know the resources you wish to assign to this territory or you have a 
small pool of people to work with, then use the List of Values (LOV) to enter 
them in the Name fields provided.

6. If you do not know the people you want assigned to this territory and have a 
large pool of potential names, then:

a.  Click Auto Assign Resources.

The Qualifying Resources window displays a list of people that fit the 
resource qualifiers values you have entered. 

b. If no people or the wrong people are found, then you must go back to the 
Resource Qualifiers tab and enter a different set of resource qualifier values, 
or you can select resources manually in the Resources tab. 

c. Select the people you wish to assign to this territory by checking the assign 
check box next to their name.

d. Click OK when you are done.

7. Next to the name of the person you wish to become the primary contact for the 
territory, check the Primary Contact check box. 

8. For each resource you can add a start and end date if you wish to limit their 
participation.

9. For each resource, enter the transactions you wish them to access. For example, 
you wish some resources to access account and contact information, but not 
lead information. To enter access for an individual:

a. Select the resource in the Resources region.
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b. Select the access type in the Access region below. 

10. Click Save on the toolbar.

Creating Escalation Territories
Use this procedure to create escalation territories. Escalation territories are alternate 
territories where transactions such as a sales lead or service call is automatically 
reassigned when certain conditions are not met, when a service call does not get 
answered for five days, for example. Escalation territories define the teams that will 
handle the escalations and so are limited to using resource qualifiers. 

Prerequisites
A plan for your territories.

Steps
1. Make the Navigator the active window.

2. From the Administration menu, select Escalation Territories.

The Territory Details window appears.

3. In the Overview tab, use the List of Values (LOV) in the Usage field to select the 
type of application you want to use this territory. Your selection limits the types 
of qualifiers you can use in the territory definition.

4. In the Category region, select the Escalation radio button.

5. Enter a name and description for the territory. 

6. If you want to limit the time the territory is effective, then enter the start and 
end dates. By default the territory become effective on the date you create it.

7. Select the resource qualifier for the escalation territory using the procedure 
outlined in Selecting the Resources for a Territory.

8. Click Save on the toolbar to save your work.

Entering Qualifier Values
Use this procedure to enter qualifier values while creating individual territories. 
You cannot use this procedure for entering qualifier values in territory templates. 
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Prerequisites
You must have the Transaction Qualifiers or Resource Qualifiers tab selected. 

Steps
1. Select the qualifier in the Qualifiers region.

2. The possible value types display below. For example, if you are entering values 
for the Interest Type qualifier used in sales applications, then you can enter 
three values: the interest type, the primary interest, and the secondary interest. 

3. Use the List of Values to select an operator.

4. Enter the value(s) in the fields provided. Some operators allow you to enter a a 
range of values; others only a single value. 

Using a Template to Create Large Numbers of Territories
Use this procedure to create a territory template that automates the process of 
creating a large number of territories. You can only create territories that use the 
same qualifiers with different values. For example, you use this procedure to create 
a separate territory for each state in the United States for your major customers. See 
Example of Creating Geographical Territories for a more detailed example.

After you create territories using this procedure, you must open up each individual 
territory and select the resources you wish assigned to each territory.

Prerequisites
■ If you want to use territory types to create territories, then you must create the 

territory types first.

■ A plan for your territories.

Note: The list of operators varies depending on the type of 
qualifier you use. Some qualifiers allow only the = symbol, for 
example.

Note: The field names change depending on the qualifier.
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Steps
1. In the Navigator, select the territory that serves as a parent to the new territory. 

If this is the first territory you are creating, then select Catch All.

2. Right-click with the mouse and select New from the pop-up menu.

The Territory Details window appears. If you selected an existing territory as 
the parent, then the Usage and Parent fields are pre-filled.

3. In the Category region, select the Template radio button.

4. If Catchall is the parent territory, then use the List of Values (LOV) in the Usage 
field to select the type of application you want to use this territory. Your 
selection limits the types of qualifiers you can use in the territory definition.

5. In Transaction Types fields, use the LOV to enter one or more transactions. The 
transaction is what the Territory Module distributes to the territories you are 
creating. You can create territories for a variety of transactions. These include 
account, lead, opportunity, and service request. Note that CRM applications 
restrict the types of transactions you can use for territory creation. You cannot 
create a territory for leads for a service application, for instance.

6. If you wish to use an existing territory type to create this territory template, 
then use the LOV to enter it in the Type field. If you use a territory type, then 
you are restricted to using the qualifiers set up in the territory type. 

7. Select the Transaction Qualifiers tab.

8. Use the LOV to enter the qualifiers in Qualifier Type.

9. From the Qualifier Mode drop-down list for each qualifier, select either Static or 
Dynamic.

10. Enter values for each transaction qualifier:

a. Select the qualifier in the Transaction Qualifiers region.

b. If the qualifier you have selected is a static qualifier, then enter the value(s) 
below. See Entering Static Qualifier Values for Templates for details.

Note: If you are using a territory type to create the territory 
template, then some of the Qualifier types are already prefilled on 
this tab.
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c. If the qualifier is a dynamic qualifier, then enter the value(s) or value set(s), 
clicking Next Value Set between each entry or set of entries. See Entering 
Dynamic Qualifier Values for Templates for details.

11. If you do not wish to add resource qualifiers for this template, then skip to step 
16.

12. If you wish to add resource qualifiers, then select the Resource Qualifiers tab.

13. Use the LOV to enter the qualifiers in the Name fields in the top portion of the 
tab.

14. From the Mode drop-down list for each qualifier, select either Static or 
Dynamic.

15. Enter values for each resource qualifier:

a. Select the qualifier.

b. If the qualifier you selected is a static qualifier, then enter the value(s) 
below. See Entering Static Qualifier Values for Templates for details.

c. If the qualifier is a dynamic qualifier, then enter the value(s) or value set(s), 
clicking Next Value Set between each entry or set of entries. See Entering 
Dynamic Qualifier Values for Templates for details.

16. Click Mass Create Territories.

The system creates territories with generated names in the form:

<template name> - GENERATED TERRITORY #<number>

For example, the territory template named "US Time Zones" generates three 
territories with the following names:

US Time Zones - GENERATED TERRITORY #1 

US Time Zones - GENERATED TERRITORY #2 

US Time Zones - GENERATED TERRITORY #3 

17. Click Save on the toolbar.

Entering Static Qualifier Values for Templates
Use this procedure while creating territory templates to enter values for static 
qualifiers. Static qualifiers have just one value in all the territories you are mass 
creating.   
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Prerequisites
You must be creating territory templates to use this procedure.

Steps
1.  Select the qualifier at the top of the window.

The possible value type(s) appear below. 

For example, if you are entering values for the Name of Customer qualifier, 
then you can enter only one value: the name of the customer. 

If you are entering values for the Interest Type qualifier used in sales 
applications, then you can enter three values: for the interest type, for the 
primary and for the secondary interest. 

2. Use the Operator list of values to select an operator.

3. Enter the value(s) in the fields provided. Some operators allow you to enter a 
range of values; others only a single value. 

4. When you are finished entering all of the values, complete the procedure for 
creating territory templates.

Entering Dynamic Qualifier Values for Templates
Use this procedure while creating territory templates to enter values for dynamic 
qualifiers. Dynamic qualifiers have a different value in each territory you create. 

Prerequisites
You can use this procedure only while creating territory templates.

Note: The list of operators varies depending on the type of 
qualifier you use. Some qualifiers, such as Name of Customer, 
allow only the = operator.

Note: The number of fields and field names change depending on 
the qualifier.
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Steps
1.  Select the qualifier at the top of the window.

The possible value type(s) appear below. 

For example, if you are entering values for the Name of Customer qualifier, 
then you can enter only one value: the name of the customer. 

If you are entering values for the Interest Type qualifier used in sales 
applications, then you can enter three values: the interest type, the primary 
interest, and the secondary interest. 

2. Use the Operator list of values to select an operator.

3. Enter the value(s) in the fields provided. Some operators allow you to enter a 
range of values; others only a single value. 

4. Click Next Value Set.

A new entry line opens.

5. Enter the next value or set of values in the same manner. 

6. Repeat this procedure for all the values for this qualifier.

Each time you click Next, the Value Set number increases by one.

For example, if you wish to enter all the states of the United States as values for 
the dynamic qualifier State, then:

a. Enter the first state.

b. Click Next.

c. Enter the second state.

d. Click Next.

Note: The list of operators varies depending on the type of 
qualifier you use. Some qualifiers, such as Name of Customer, 
allow only the = operator.

Note: The number of fields and field names change depending on 
the qualifier.
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e. Repeat the procedure for each of the remaining states.

7. When you have entered all of the values, complete the procedure for creating 
territory templates.

Example of Creating Geographical Territories Using a Template
Suppose you wish to create territories for telephone support and field service 
engineers for different city branches of two large customers IBM and Sun 
Microsystems. 

Also assume you want to ensure the field service engineers are located in the same 
city as the branch they service. 

You want to create four territories for each city. For example:

■ IBM-San Francisco Telephone Support

■ IBM-San Francisco Field Service

■  Sun Microsystems- San Francisco Telephone Support

■  Sun Microsystems- San Francisco Field Service

Below are the sample steps required to create territories for this hypothetical 
example. 

Sample Steps
1. Navigate to Admin >Territory Management >Mass Create Territories.

2. In the Overview tab, set up the basic information about the territory template.

3. In the Transaction Qualifiers tab, set up the two transaction qualifiers and their 
values: customer name and city. 

4. In the Resource Qualifier tab, enter the qualifiers that are used to pick the 
resources who handle the transactions you set up in the Transaction Qualifier 
tab. 

If you are setting up geographic territories and you wish the resources to come 
from the same geographical area as the transactions, then you must set up a 
geographical structure for the resource qualifiers that is parallel to the one you 
set up for the transaction qualifiers.

In this example you wish to ensure that the field service engineers are from the 
same city as the accounts they service. The geographical transaction qualifier is 
City, so you must use City for your resources as well. 
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The two resource qualifiers used in this example are: Job Title and City. Here are 
the detailed setup steps:

5. Click Mass Create Territories.

The system creates territories with generated names in the form:

IBM/Sun by city - GENERATED TERRITORY #1

IBM/Sun by city - GENERATED TERRITORY #2

IBM/Sun by city - GENERATED TERRITORY #3

...

6. Open up each generated territory.

7. Change the generated name to one you recognize.

8. In the Resources tab, click Auto Assign Resources.

9. The Qualifying Resources window displays a list of people that fit the resource 
qualifiers values you have entered. 

10. Select the people you wish to assign to this territory by checking the assign 
check box next to their name.

11. Click OK when you are done.

12. Next to the name of the person you wish to become the primary contact for the 
territory, check the Primary Contact check box. 

13. For each resource you can add a start and end date if you wish to limit their 
participation. 

14. Click Save on the toolbar.

Setting Up Overview Information
Here are the steps for setting up the template overview information for the 
example:

1. In the Usage field, use the List of Values (LOV) to select the type of application 
using this territory template. Your selection limits the types of qualifiers you 
can use in the territory template definition.

2. Enter a descriptive name and description for the territory template. In this 
example: IBM/Sun by city.
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3. If you want to limit the time the territory template is effective, then enter the 
dates. By default the territory template becomes effective on the date you create 
it.

4. In the Navigator, select the parent territory for the territories created by the 
template. This is the territory that is one above in the territory hierarchy.

5. Right-click with the mouse in the Parent field. This enters the territory name 
highlighted in the navigator as the parent territory.

6. Use the LOV to select one or more types of transactions that will be assigned to 
each territory. Available values depend on your application and include 
account, lead, opportunity, and service request.

Setting Up Transaction Qualifiers
Here are the steps for setting up transaction qualifiers for the example:

1.  Select the Transaction Qualifiers tab.

2. Use the LOV to enter the City and Customer Name qualifiers in the Qualifier 
Type fields.

3. From the Qualifier Mode drop-down list, select Dynamic for both qualifiers 
because both change in the territories are creating.

4. Select the City qualifier by clicking on it.

5. Select = as the operator.

6. Enter the first city, San Francisco, as a value for the City qualifier.

7. Click Next.

8. Repeat steps 12 through 14 for every city you are creating territories for.

9. Select the Customer Name qualifier in the qualifier region.

10. Select = as the operator.

11. Enter the first of the two companies, IBM, as a value for the Customer Name 
qualifier.

12. Click Next.

13. Enter Sun Microsystems as a value for Customer Name in the same way.
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Setting Up Resource Qualifiers
Here are the steps for setting up resource qualifiers for the example:

1.  Select the Resource Qualifiers tab.

2. Add the Job Title qualifier at the top of the window.

3. Add the City qualifier at the top of the window. 

4. From the Qualifier Mode drop-down list, select Dynamic for both qualifiers 
because both change in the territories are creating.

5. Select the City qualifier by clicking on it.

6. Select = as the operator.

7. Enter the first city, San Francisco, as a value for the City qualifier.

8. Click Next.

9. Repeat the preceding three steps for every city you are creating territories for.

10. Select the Job Title qualifier at the top of the window.

11. Select = as the operator.

12. Use the LOV to select the first of the two job classifications: Telephone Support.

13. Click Next.

14. Enter the second job classification, Field Service, in the same way.

Creating Custom Qualifiers
You can create qualifiers for use within your application. This procedure outlines 
the creation of a sample qualifier that assigns territories by a company’s Dunn & 
Bradstreet number.

Prerequisites
■ Knowledge of SQL.

■ Understanding and access to the Technical Reference Manual for your 
application.

Sample Steps
1. From the Admin menu, choose Setup Qualifiers.
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The Setup Qualifiers window appears.

2. Click Define Custom.

The Organization Name displays the organization that can use this custom 
qualifier. This is the same organization as the one assigned to the Territory 
Administrator. A System Administrator can change the organization by 
modifying the Territory Administrator responsibility.

3. Use the Source Name list of values (LOV) to enter the Oracle CRM application 
using this custom defined qualifier.

4. Use the Qualifier Type LOV to enter the type of qualifier you wish to create. To 
create the Dunn & Bradstreet qualifier in this example, select Account.

5. Use the Table LOV to select the table that is the source of your qualifier. In this 
example, HZ_PARTIES. 

6. Enter the Table Alias. In this example: HZP. This is the alias for the table that is 
the source of the qualifier. 

7. Use the Column LOV to enter the table column. For this example, select DUNS_
NUMBER.

8. Enter the alias for the column that the qualifier is sourced from. For this 
example, DUNS_NUMBER.

9. Enter the Name of the Qualifier. For this example, Dun & Bradstreet 
Number.

10. Enter a Description for the Qualifier.

11. Make sure the Enable Flag check box is checked to enable this qualifier.

12. Select one of the Display Type radio buttons depending on what type of data 
representation you wish the users to see. 

 This selection determines how values are displayed in the Transaction Qualifier 
and Resource Qualifier tabs of the Territory Details window. 

For example, the list of values for a customer contains two values: a customer 
name and a customer ID number. If you select the Char option, then the user 
entering a customer name in the Territory Details window sees the actual 
customer name. If you select Numeric, then the user sees the customer ID 
number rather than the customer name as the displayed value. 

The setting you choose does not affect the way data is processed by the module, 
only its display.
134 CRM Foundation Components Concepts and Procedures



Creating Custom Qualifiers
13. In SQL for List of Values text box, enter the SQL statement you wish to use to 
populate the list of values that is used by territory administrators to enter value 
for the qualifier in the Territory Details window.

For this example, enter: SELECT hzp.duns_number col1_value, NULL 
col1_value FROM hz_parties hzp

It is important to enter the column aliases (col1_value and col2_value), as these 
are mapped to the columns displayed in the LOV in the Territory form.

14. Click on OK to save your work.

15.  The final step in qualifier creation is to modify the view that corresponds to the 
territory qualifier type. This view is the source of the transaction records that 
are assigned to territories.

In order to use the Dunn & Bradstreet Number qualifier, you must add it to the 
view as shown below. 

This is done by changing the value of attribute1 from NULL to 
PARTY.DUNS_NUMBER.

Each product passing values into the Territory Module API has its own view. 
Please refer to your Technical Reference Manual for more information.

Sample view:

CREATE OR REPLACE VIEW apps.RELEVANT_VIEW
(  city
,  postal_code
,  state
,  province
,  county
,  country
,  interest_type_id
,  primary_interest_id
,  secondary_interest_id

Note: The Special display type radio button is not enabled in this 
release.

Note: The view name and structure varies with each application 
using the territory module.
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,  contact_interest_type_id
,  contact_primary_interest_id
,  contact_secondary_interest_id
,  party_site_id
,  area_code
,  party_id
,  comp_name_range
,  third_party_flag
,  num_of_employees
,  line_of_business
,  party_relationship_id
,  sic_code
,  attribute1
,  attribute2
,  attribute3
,  attribute4
,  attribute5
,  attribute6
,  attribute7
,  attribute8
,  attribute9
,  attribute10
,  attribute11
,  attribute12
,  attribute13
,  attribute14
,  attribute15
)
AS
SELECT
    LOC.CITY,
    LOC.POSTAL_CODE,
    LOC.STATE,
    LOC.PROVINCE,
    LOC.COUNTY,
    LOC.COUNTRY,
    INT.INTEREST_TYPE_ID,
    INT.PRIMARY_INTEREST_CODE_ID,
    INT.SECONDARY_INTEREST_CODE_ID,
    INTCI.INTEREST_TYPE_ID,
    INTCI.PRIMARY_INTEREST_CODE_ID,
    INTCI.SECONDARY_INTEREST_CODE_ID,
    PARTY_SITE.PARTY_SITE_ID,
    CONT_POINT.PHONE_AREA_CODE,
    PARTY.PARTY_ID,
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    PARTY.PARTY_NAME,
    DECODE(RELATION.PARTY_RELATIONSHIP_TYPE, ’PARTNER’, ’Y’, ’N’),
    PROFILE.EMPLOYEES_TOTAL,
    PROFILE.LINE_OF_BUSINESS,
    RELATION.PARTY_RELATIONSHIP_ID,
    PARTY.SIC_CODE,
    PARTY.DUNS_NUMBER,
    NULL,
    NULL,
    NULL,
    NULL,
    NULL,
    NULL,
    NULL,
    NULL,
    NULL,
    NULL,
    NULL,
    NULL,
    NULL,
    NULL
FROM
    HZ_PARTIES PARTY,
    HZ_PARTY_SITES PARTY_SITE,
    HZ_LOCATIONS LOC,
    HZ_CONTACT_POINTS CONT_POINT,
    HZ_PARTY_RELATIONSHIPS RELATION,
    HZ_ORGANIZATION_PROFILES PROFILE,
    AS_INTERESTS_ALL INT,
    AS_INTERESTS_ALL INTCI
WHERE
    PARTY.PARTY_ID = PARTY_SITE.PARTY_ID
AND PARTY.PARTY_ID = RELATION.PARTY_ID (+)
AND PARTY_SITE.LOCATION_ID = LOC.LOCATION_ID
AND ((PARTY.PARTY_TYPE = ’PERSON’) OR (PARTY.PARTY_TYPE = 
’ORGANIZATION’))
AND CONT_POINT.OWNER_TABLE_NAME(+) = ’HZ_PARTIES’
AND CONT_POINT.OWNER_TABLE_ID(+) = PARTY.PARTY_ID
AND PROFILE.PARTY_ID = PARTY.PARTY_ID
AND INT.ADDRESS_ID = PARTY_SITE.PARTY_SITE_ID
AND INTCI.ADDRESS_ID = PARTY_SITE.PARTY_SITE_ID
AND INT.INTEREST_USE_CODE = ’COMPANY_CLASSIFICATION’
AND INTCI.INTEREST_USE_CODE = ’CONTACT_INTEREST’
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